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Welcome to ConceptDraw PROJECT v14 for Windows

A full-featured project management solution with all the necessary functions right at your fingertips.
Generates an extensive variety of reports on project and task statuses on macOS and Windows
platforms. Centralizes project information through embedded documents and hyperlinks. Unique
Multiproject Dashboard manages multiple projects from a single file. Powerful integration with other
ConceptDraw products makes project management easier than ever before.

Manage Plans, Reports, and Changes

Benefits

ConceptDraw Maintenance Assurance

Technical Support

Manage Plans, Reports, and Changes

ConceptDraw PROJECT makes planning projects and managing change easy because of the project
focused tools that manage every aspect you, the Project Manager encounters. ConceptDraw PROJECT
builds on established project management methodologies while simplifying the process of managing
project data, making effective responses, and working with project teams.

ConceptDraw PROJECT helps you manage all of your project variables from a single view. You can
quickly generate a broad range of One Click Reports for project variables such as resource usage, task
planning by resource, and budgets. Display up-to-data status on dashboards to keep you current as the
variables change.

ConceptDraw PROJECT is the complete solution to manage single or multiple projects and their
associated resources with a very low cost of ownership.

Your Benefits

ConceptDraw PROJECT gives you the tools to evaluate your project planning. Streamlines meetings and
ensures more effective planning and control thanks to live project dashboard illustrations, mind map
reports, and knowledge metrics.

ConceptDraw Maintenance Assurance
We have developed an innovative maintenance program that makes sure you stay up to date. At the time
of your buy a ConceptDraw product, you are able to purchase ConceptDraw Maintenance Assurance .

Technical Support

We offer unlimited free technical support to our users.

To send us a problem report or feature request, submit the ticket form in the Help Desk section on our
Web site.

Replies are normally sent within one business day. We are always happy to answer your questions and
hear your feedback.



https://www.conceptdraw.com/helpdesk/how-to-upgrade-from-previous-versions
https://helpdesk.conceptdraw.com/ticket.php

Toolbar Tour
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The ConceptDraw PROJECT toolbar provides quick access to functions that are commonly performed
within the program.

Quick Access
File

Home

View

Share




Quick Access

B E™~EE

Quick Access menu facilitates access to the most frequently used functions. It is located at the top of
Toolbar.

Tl New Start a new document

| Open Open an existing document

M save Save the current document

¥ Undo Undo the last action

™ Redo Redo the last undone action

@ Print Send the document directly to the default printer without making changes
. Print Preview and make changes to pages before printing

Preview




Mew

Open Recent Documents

Software Development Alpha-r.cdpz

@ C\Users\anna\Documents\My ConceptDraw
——  product_launch.cdpz
® C\Users\anna\Documents\My ConceptDraw
——  Meetings.cdpz
@ C\Users\anna\Documents\My ConceptDraw
Import ) ] o
——  Commercial Construction_mnultiproject.cdpz
® C\Users\anna\Documents\My ConceptDraw
Export ——  Business Startup.cdpz
@ C\Users\anna\Documents\My ConceptDraw
—— Audit.cdpz
® C\Users\anna\Documents\My ConceptDraw
Properties
Opticns
New Create a new document
Open Open an existing project
Recent Show recently opened files
Sawe Save the current document
Sawe As Sawe a copy of the document
Import Import the document
Export Export the document
Print Preview and print the document
Send Send a document
Close Close ConceptDraw PROJECT
Properties Open the Document Properties dialog

Options Open the Options dialog




Preview and print the current ConceptDraw PROJECT file

_ Print Send the document to the default printer as it is.

= Use the View tab to setup the printed document view.
illPrint Preview Opens Print Preview tab

® Print to Print to Adobe PDF using the current print settings
%8 Adobe PDF

Send the current document
E E-mail Send a copy of the document via e-mail as attachment

=_ Open in MINDMAP  Open the current document in ConceptDraw MINDMAP
|




Print Preview

Preview and make changes to pages before printing.

BoTH [N [Commercial Construction_multiproject.cdpz - Gantt Chart] - ConceptDraw PROJECT - o x
F— He-
\ ] o ® Every = i
g '.\ Select Printer Select View to Print % Original Size Print Al Every Page i ,;’ ] ®
= Snagit 13 ~| | Active view (Gantt Chart) ~ Dates Range | 6/26/202 | - [10/26/202: Legend Page o b = NextPage
Print  PDF Fitto

Scale Margins Orientation  Size Close Print
- - - A Preview
Preview

& Printing Properties Do not Print Mone
Print Print View Print Scale Table Gantt Chart Legend Paper Setup

Print
ZH Print the current document

,!’..‘ Print to Adobe PDF using the current print settings

Brother DCP-80650 «
# Printing properties Select the printer and set the printer properties

Print View
Select exactly the view you need to print: Gantt Chart, or Multiproject.

Select view to print

Active view (Gantt Chart) =

MultiProject
Scaling
Actual - Print the document in zoom 100% of the actual size.
Fit to - Set the number of pages , your document will be printed

Grid
Set the print options: Print the outline and Gantt chart , or Gantt chart only

Timescale

The timescale printing radio button allows to print the entire project timescale.
The dates range selection allows to select the time period to print.

"Do not print" radio button allows to print the entire document without timescale

Legend
ﬁ Phase J\ Deadline = Link
Task <> Milestone

Every page - Print the legend at the bottom of each page.
Legend page - Print the separate legend page.
None - Do not print legend.

Page Setup

Margins - Set the margins for the current document.

Orientation - Switch the pages between portrait and landscape layout.
Size - Choose the page size from the drop-down list.

Preview

Previous page/Next Page - Navigate between pages on page preview.
Fit page - Zoom the document so that entire document fits one page.
Close - Close Print preview.




Import

Create ConceptDraw PROJECT document from other file types. The Import section provides the access
to ConceptDraw PROJECT import opportunities:

MS Excel - Create project in new document from text outline

MS Project File - Creating new document on the basis of information taken from Microsoft
Project *.mpp document

Mindjet MindManager - Creating new document on the basis of information taken from
Mindjet MindManager *.mmap document

il B il

Text outline - Creating new document on the basis of information taken from Microsoft Excel
* . xIsx workbook




Export

Create other file types from a ConceptDraw PROJECT document. The Export section provides the
access to ConceptDraw PROJECT export opportunities

ﬁ Adobe PDF - Export the document to Adobe PDF

H ! MS Excel - Save project tables from all views as Microsoft Excel workbook ( *.xIsx)

MS Project File - Export the document to Microsoft Project XML

=
L:I

Mindjet MindManager - Save the document in Mindjet MindManager *.mmap format

H

Text Outline - Export the document to the text outline

il




Home
BOTHY~@R [Audit.cdma - Gantt Chart] - ConceptDraw PROJECT
e o BESFEE QSEFERRETIIIES
Clipboard
= Paste Paste content from the Clipboard
3{’ Cut Cut selection and put it into Clipboard.
.
- Copy Copy the selection and put it into the Clipboard.
Format Text
— : Font Select font face
Arial Unicode Ms: =12 -
Font size Select font size
= LT F - At .
IWrapted Ab™ A A Grow font Increase font size
Shrink font Decrease font size

Solutions

Select View

Make upper case
Make lower case
Make title case

Make sentence
case

Wrap text

Solutions

Gantt Chart

Resources

Multiproject

Resource usage

Reports

Convert selected to upper case
Convert selected to lower case
Convert selected to title case

Convert selected to sentence case

Makes all content visible within a cell by
displaying it on multiple lines

Activate Solutions panel

Switch to Gantt Chart View

Switch to Resource list

Switch to Multiproject Dashboard

Switch to Resource usage view

Displays the generation window of the last report.
If no reports have been created yet, a window will
open for creating the first report in alphabetical
order in the list of available reports, provided in the
Solutions panel.
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Microreports

d

General

Link

Link

Move

[r—

O

in

I M ul] s

Microreports

Add sub item

Delete

Add text box

Link

Unlink

Edit button

Indent

Outdent

Up

Down

Generate Microreports

Add new item to end

Inserts new item into selected position

Add sub item to selected item

Delete selection

Add a text note to selected task or phase. You can use the
Text Box to add work details, supporting information, or other
notes to tasks and phases on a project Gantt chart directly. A
Text Box can contain just a text with no formatting.

E Designing F
Feature [
R T
Database architecture ﬁ
User interface , ERD |
diagram

o o L]

Link two or more selected items
E Finish to start

|:: Start to start

O Start to finish

::I Finish to finish

Unlink two or more selected items

Edit predecessors using the Predecessors dialog

Indent selected item (Move selected item one position right)

Outdent selected item (Mowe selected item one position left)
Mowe selected item one position up

Movwe selected item one position down
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Go To

’:3: Selected
=

’:j; Today
||

Markers

B B [ Markers

aEE Edit Markers butt
X it Markers button

Calendar

Editing
n Find
Replace
ﬂ Smart Enter

Show selected task on Gantt Chart

Show today's tasks on Gantt Chart view

Mark selected item with selected color

Opens the Edit markers dialog

Shows Document Properties dialog, Calendar tab

Sawve Baseline settings for selected tasks

Activate Eind dialog

Activate Replace dialog

On/Off the Smart Enter Mode.
When the Smart Enter Mode is active a new Task is added
by the Enter key.




Microreports
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[Audit.cdma - Gantt Chart] - ConceptDraw PROJECT

ConceptDraw PROJECT gives you an opportunity to communicate with your team faster by using micro-
reports.

A micro-report is a small piece of project information associated with specific task, phase, resource or
project, which you can send via e-mail. It’s a great time saver feature for daily communication with your

team, and it allows you to report project statuses quickly and easily. The list of micro-reports for

choosing is available:

o from the context menu of the the task, phase, resource or project;
¢ from the Micro-reports button D on the Home tab.

List of reports available for various project tables:

Gantt Chart
Phase

Task
1.
2.
3.

Deadline reminder for all projects.
Deadline reminder for the current project.
Today tasks list.

Critical tasks list.

Today tasks list with assigned resources
Today resources list

Deadline reminder for all projects.
Deadline reminder for the current project.
Task status.

Resources

©OND>OAWN =

Today tasks list for all resources.
Today tasks list.

Milestones.

Objectives.

Projects list.

Next tasks.

Assigned tasks.

Critical tasks.

Deadline reminder for the selected resource.

Multiproject Dashboard

aorDd =~

Deadline reminder for all projects.

Today tasks list.

Today resources list.

Nearest milestones

Deadline reminder for the current project.




13

You need to select the desired type of microreport from the drop-down list, and it will be generated as a

ready-to-send e-mail. Microreports of all types, except reports on deadlines, are generated in both text
and mind map form as ConceptDraw MINDMAP files (CDMZ), attached to the email message.

H © G 5  Assigned taskss Martha Erown - M... &= (]
File Message Insert Options Format Text Review Help G Tell me
| To.. | |William.Bmwn@example.mm |
=\ e, | |
Send . -
Subject |A55|gned tasks: Martha Brown |

= s 2023-08-31_19-12-39_Assigned tasks.cdmz
Attached L Q 5 KB N

bemm position [task]

PERT diagram [task]
Database architecture [task]
User interface [task]

Bug fixing [task]

eB
- O Decomposition

Assigned tasks Plarnin
.. O/ 88
[T

) \ FERT disgram
© = Martha Brown & ©
O Bug fxing

O _Im plem entation —_ O Dstabasze amhitecturs
L . . —
O Designing ‘_] @
'\ O User inter&oe

Deadline Reminders

A deadline is a target date indicating when a project task must be completed. If the deadline expires and
the task is not completed, the deadline becomes overdue. Deadline Reminders are used to inform
employees inwolved in a project of the task's upcoming and overdue deadlines. Microreports on deadlines

are generated as email messages addressed to employees assigned to tasks that have upcoming or
overdue deadlines.
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Select a project, task, or resource. You need to choose the needed type of Microreport from the drop-
down list. Ready-to-send e-mails will be generated. A task is included in the Deadline Reminder if all of
the following conditions are met. You can check them on the Task panel.

1. The task has a Deadline parameter checked.

Dates
Start: 8/31/2023 &:00 AM [~
Finish: 10/10/2023 5:00PM [
Deadline: 9132023 12:00 AM -~

2. Task completion is less than 100%.

Task h
Proje Task | Assign Links | Reso Hype
Info
Mame: | ,.L"..DN"."EF‘.SIDN F‘.EQUIF‘.EMEN|
Duration: 29 > |Days v
Complete: 45 8 ?

3. The Task Finish date is later than the report date.

Dates
Start: 8/31/2023 &:00 AM [~
Finish: 10/10/2023 5:00PM [
Deadline: 9132023 12:00 AM -~

Ready-to-send deadline reminders can be created automatically every time you run a project file. Simply
check the "Generate deadline Microreports” option in the ConceptDraw PROJECT Options dialog box.
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Project Baseline

ConceptDraw PROJECT provides the possibility to set a Project baseline. A Project baseline is a
snapshot (copy) of the current main values of the project and tasks (Start, Finish, Cost). It is used for
assessing performance, and improving the estimation accuracy. Save a baseline when the planning of
project is completed and later compare with it the real values at the implementation and after completion
your project.

To sawe a Baseline, click the Save Baseline button = on the Home tab. The following message will
appear:

1Sk Ialelsl 1 [Financial.cdptz - Gantt Chart] - CenceptDraw PROJECT - B X
Home | View  Shae ne-
— y— - - - — [
c P = = F
hiew T BES TEE @ SD= R
Paste B Copy BB yr A A Solutions |G Resources Muliproject Resource Reports  Microreports Insert_ Add Find Replace Smart
P Wi Tt ab- AT A Chart e N age ! Subaern Enter
Wasning

Baseline was resaved. Note. that you can undo this action

To undo the last action, click the Undo button on the Quick Access Toolbar or Ctrl+Z on the keyboard. .
Baseline in ConceptDraw PROJECT includes three parameters: Baseline Start, Baseline Finish, and
Baseline Cost. To display them on the Gantt chart, use the Column Customization dialog. Also the value
of Baseline cost can also be found on the Task panel. As the project progresses, the Baseline will help
you measure any changes in the plan and to determine any differences from your original plan and the
actual state of your project. You can highlight baseline using the button on the View tab.

- [m] =
ifo
—_— Critical Path = f | p—| —"—-'l
=—3 E - == g
vl [w] Aspegned Retsuncy e L . 1_!'
ﬁ §oE= Baseline | Select  Panels Windows
+] Shorw Text Bowes . . .
Themes e Hide Columms | Fareh and Windows
s ] dth Quarter 2023 st Quarter 28 Ind Gz & PR
Aug Zap Ot How Dec Jan Feb War age
—_— hons: ¢
?I_. Ardew Anceticn Suten White Durators 45 S |Days v
=l Andrew Anderson, Sulan Wts Compiete: D e
i Kanen Marin; Wiliam.Jones [rrrn— 0
il
--_-| Eacen Martin, Wilkam Sones
I Fractys (R ]
F | Marker: [r— -
Costs:

- Micha#i Smith; Davsd Harris

Bassine: 18400 § 2
[ e Laura Rodriguez; Hancy Sama

e EE ]
==l=i- Hancy Garda; Laura Rodngues
1 = Dates =
10N Hangy Gancia; Laura Rsdrigues Ctart 0 BaM D
10242023 Mancy Garcia; Laura Rodrigues = E,,m” S:00 6 —e,]
Firish: 8 E ]

Sugan White

Desdines 0| srorzoss 1m0 an
Karen Marin =
william. Jonis
Tyoes Frced Uite: ~
l_[_] Helen Clark; Chaneg Lewis .
+ Mk Clark ST ’ o
LJ Tk Types
~E—

- Michasl St David Harris ™,
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[Audit.cdpz - Gantt Chant] - ConceptDraw PROJECT

g v

:

£ il
“
-
-1

I |

'.l

H]

Select View

I

—_—
]

|

Timescale

+
»

Ay 4

Gantt Chart: Switch to Gantt Chart View.

Resources: Switch to Resource list.

Multiproject: Switch to Multiproject Dashboard.

Resource usage: Switch to Resource usage view.

Zoom in

Zoom out

Timeline: Adjust zoom so, that the entire project timeline fit the screen.

Scale: Show the scale choice drop-down list.

The button at the right bottom of the section opens Timescale dialog (A timescale ruler (or calendar)
measures time for the tasks in your document. )
Expand/collapse

E-
]
E-

] p—
] p—
] p—

=

Expand all: Expand all sub items.

Collapse all: Collapse all sub items.

Expand: Expand selected item.

Collapse: Collapse selected item.

Outline level: Show tasks of the certain outline level.
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Filters
Thaeta: <z x o Oelect Filter:
sewpreses [ s Select the embedded filter and activate Filters mode.
e Y ] Apply previously selected filter.
Clear the current filtering.
@ Invert the current filter.
Show phases: Show/Hide phases.
Show Highlight: Show/Hide Highlight.
Edit Filter button: Open the Filters Dialog.
Themes
= = == Themes: Select the one of the available Gantt chart views
Show/Hide
¥| Critical path Critical path: Show/hide the critical path

v| Assigned resources - Assigned resources: Show/hide the resources assigned to tasks on the Gantt
v showtetbores  ghow text boxes: Show/hide _text boxes
[_=-' Baseline: Show/hide the saved project baseline on the Gantt Chart
L]

Columns

Customize columns: Open the Columns customization dialog and select columns to
display in the project outline.

Select

Ld

Panels and Windows

=  Panels: Manage Eloating panels.
==

Panels

-

: Windows: Shows the list of opened windows.
Wind ows

-
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Gantt Chart

Typically each project has tasks and phases. Every task represents a single unit of work — a single
step in a multi-step project. A group of related project tasks can be joined into phases.

The Gantt chart window consists of two parts: the project outline — a list of the project tasks and
phases and its graphic representation — Gantt chart.

The Gantt chart is the defa_ult view of the project file when you run ConceptDraw PROJECT. Also, it is

—_—
|

accessible by the button ==~ on the View tab.

Name Start Frish Compleke September 2023 October 2023
w3 w35 w35 w3t wib wid vl wid 1 WAl Wil W
@ Stake bnes and grades 8282023 QEr2023 100 % [ _Survs',-or 1
4 % Clearing and Site Grading 91402023 912212023 BT % —[ ! |4} Biob's Excavation; Excavator [ 1]
5 %  Utilities 913/2023 1001712023 100 % ¥ | Surveyor 2
& % Excavation Bi14/2023 Si4/2023 100 % 1 Bobis Excavation | 100 %]; Excavator [ 1]
7 % E Foundation and Backfill Q412023 101502023 2% ¥ | —
B Footings 9/18/2023 10i5/2023 0% ﬂ . Surveyor 1
8 % Spread Foolings 9142023 92212023 53 % | #Baker Floonng, Concrete mixer [ 1]
10 % Concrete Piles 211/2023 2122/12023 30 % . #Bob's Excavation; Concretle mixer [ 1]
1% Slab on Grade 91112023 91212023 100 % |: ! l Surveyor 2
12 % Walls 9/11/2023 9/29/2023 3% L — Baker Floonng; Truck [ 1]
13 % E Exterior Wall Surfaces BI232023 Q262023 A% F _—
14 En:k BI23/2023 9/26/2023 40 % _ Bob's Excavation Excavator [1]
>«

antt EEEREONELESTAITAN Lease a Mew Facility  Kitchen Renovation  Site Arangerment

Actual Cost= 23

1. A task can be added to the document with one of the following methods:

e By pressing Enter

¢ Using the General section on the Home tab

¢ Applying the command Insert New Task from the context menu.
To turn the selected task into a phase, use the Outdent command. To add a task to a phase, use the
Add Subtask command.
All parameters of the project tasks and phases can be specified in the Tasks dialog. Some parameters
can be specified in the context menu and on the Gantt chart.
Columns that contain the project outline information can be managed using the Column Customization
dialog.
The width of a column can also be changed. For this set the cursor to the right edge of the column (the
cursor should turn a double-sided arrow) and drag it to the needed direction.
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2. The Gantt chart displays task as bars. Bars are arranged in accordance with the timescale, displaying
the task start /end time and its duration.
The timescale can be changed. This can be done in the Timescale dialog, that can be accessed from the
context menu.
Also can change the task start/end date, its duration and completion . To change start/end dates move
the bar by your mouse. To change the task duration draw by the right edge of the bar, to change the
percentage of completion draw by the left edge. In both cases the cursor should turn a double-sided
arrow. The non-completed part of the task and the completed one are shown in different colors,
depending on the current Theme. To show/hide the resources involved in these tasks, use the Show/Hide
section in the View tab.
Links between dependent tasks are shown with arrows. The most common link type, finish to start, is
assigned by the following way: first select the tasks to which you want to assign links, and then use one
of the following:

e The Link group in the Home tab

e The context menu of the Gantt chart view
Any link type can be customized using the dialog Predecessors.
The widths of the text and graphic parts of the diagram can be changed. For this set the cursor on the
dividing line and draw to the needed direction.

3. The navigation bar at the bottom of the Gantt chart window allows you to quickly navigate between the
multiple projects Gantt windows that your multiproject contains. Use the "Multi Gantt" option to manage
all the projects of a multiproject file from a single window.

. N 5 - — — w33, 13Aug 2023 w34, 20 Aug 2023 w35, 27 Aug
ame wrasen art o OMPI®E 43 44 15 16 17 18 19 20 21 22 23 24 25 26 27 28
1 * [ Construction Project 52d 8772023 10117/2023 62 %
22 ¥ @ Lease a New Facility 65d 8142023 1110/2023 17T% ¥ -
55 % [ Kitchen Renovation 69d 7/28/2023 111212023 25%
177 % O Site Arrangement 65d 8M7/2023 11152023 17%
178 % E PROGRAMMING 18,32 days? 6d 8M7/2023 812412023 43 % L —__-,
Tenant, Leasing Agent, and
179 % Architect meetto establish 3d 8M7R2023 8/21/2023 50 %
Program 9
Tenant Sign-off on approved,
180/ % il Erogam 3d 82202023 | 82412023 35% L |
< > < >

[EMBREERENN Construction Project  Lease a New Facility  Kitchen Rencovation  Site Arrangement

Budget: 1,045,880 § Actual Cost: 506,680 § Profit: 539,200 §

Gantt Chart Context Menu

Access the most frequently used operations at Gantt Chart window via the context menu.
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Name

Construction Contract Award 1
Accept Site
# Stake lines and grades
Clearing and Site Grading
Utilities
Excavation
= Foundation and Backfill
Footings
Spread Footings
Concrete Piles
Slab on Grade
Walls
B Exterior Wall Surfaces
Brick

Exterior Tim

 Rough.in Ductwork,
~ Plumbing and Electrical

Install Heatpumps
WVenting

Panelboards

Telephone, Secunty, and
Electrical Wirina

Gantt Chart Context Men_u
Arial - |10

A A AB ab AB ab & -

Copy

Paste

B

Paste as... ]
Cust

Select All

Insert Mew Task

Add Mew Subtask

Delete

Indent

KA WAl

Outdent

Customn Mark

Tasks Link ¥
Create MINDMAP File

ol Add Text Box

Markers

EEPDEEENX

Start Finish Complete
8/7/2023 0%
8/14/2023 0%
8/28/2023 9812023 100 %
90472023 972212023 67 %
9/13/2023 10/17/2023 100 %
8/14/2023 9/4/2023 100 %
9412023 10/5/2023 32%
9/18/2023 10/5/2023 0%
9472023 222023 53%
9/11/2023 9/2212023 30 %
9/11/2023 9/12/2023 100 %
9/11/2023 9/29/2023 3%
BI2312023 2612023 40 %
8/23/2023 912612023 40 %
8/23/2023 0%
962023 912612023 67 %
612023 9/26/2023 3%
612023 91212023 100 %
9/6/2023 100 %
9/6/2023 9192023 100 %

ust2023 September 2023 October 2023
wi2 w33 w4 w35 w3 wiT wig wlg wil wdl wal wdl
- 812023
Arial |10 -
A A AB ab AR Ab & ” Surveyor 1
- Bob's Excavation; Excavator [ 1]

Copy
Paste

[

Paste as...
& Cut
Select All
Insert Mew Task
Add New Subtask
Delete

Indent

ET ) Al

Custom Mark
Tasks Link
Create MINDMAP File
o Add Text Box
Markers

EEIEEENEX

1 J Surveyor
Bobls Excavation [ 100 %]; Excavator [ 1]

’ —
Surveyor 1

3 ¥Baker Flooring; Concrete mixer [ 1]

—:[ #Bob's Excavation; Concrete mixer [ 1]

[ | Surveyor 2
I Baker Flooring; Truck [ 1]
P——

Bob's Excavation Excavator [ 1]

I
| Bob's Excavation

9/6/2023; Surveyor 2

Baker Floonng; Truck [ 1]

| Baker Floonng; Truck [ 1]

Text Format

Microreports

Copy
Paste

Paste as

Cut

Select All

Insert New Task
Add New Subtask
Delete

Indent

Outdent
Custom Mark
Task Link

Create MINDMAP

Add Text Box
Markers

Change the text format of the project schedule
Generate Microreports

Copy the selection and put it into the Clipboard.
Paste content from the Clipboard.

Options for pasting tasks copied to the clipboard.
Cut selection and put it into Clipboard.

Select all tasks.

Inserts new task into selected position.

Add sub task to selected task.

Delete selection.

Indent selected tasks (Mowe selected item one
position right).

Outdent selected tasks (Move selected item one
position left).

Mark the tasks that need to be represented in the
diagram.

Link two or more selected items.

Generate a mind map (*. cdmz) from selected
tasks.

The file will be opened in ConceptDraw MINDMAP
Add a text box to selected item.

Make the selected items looking like marked with
a highlighter.

File
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Gantt Chart Timescale Context Menu

#, ZoomIn cl== Zoom In Displays timescale in more detail (day instead of weeks, etc.)

=, Zoom Qut Crl+- Zoom out Displays a more generalized timescale (weeks instead of days,
Timescale.. Ctrl+Alt+T etC_)

B Calendar.. Timescale  Calls Timescale dialog that allows to customize timescale

appearance. It gives more possibilities for this than Zoom In and
Zoom Out commands. On the other hand mentioned commands
allows to change calendar scale quicker.

Calendar Opens the Standard Calendar dialog
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Resources

By clicking the button ™ on the View tab, you open the Resources window. This window contains a
list of resources with their characteristics.

1 Hamg Type Cod Group E-Mad Habes

1 Bob's Excavation Nark 1655h  Excavabon ob excavalion@amai con =
2 % Surveyor 1 Work 10050 Surveyor w2 Samail =

Baker Flooring Noark 1405h  Floonng ker Tlooringdganm. =

@Surae;nr? Nork 100 8"  Surveyor By Rgmail com -
5% Excavator Equipmant T00 5 Excavation Landscape
BV Truck 3 Equipment 700§ Excavabion Landscape
T % Concrete miowr Equipment TO0% Floonng
B % Tom Sheldon W 150 50  SurveyorExcavation  flom_sheldong@gmalcom =
8 ¥ Rich Gannon \@ 150 %M  SuneyorFlooring rich_gannongigmalcom =
10 % Jod Smith Work 15:: Sunaryar Floofing o@_smifE@gmail com =
1" % Tom Famell Wiark 154 urveyor,Landscape [ =
12 ¥ Mike Grabowski Wiork 150 5h Surieyorhvac | E & -
13 % Jang Postal Wark 1505M  Lancscape [ 7 =
14 ¥ Pat OTormey Wark 150 %h  Landscape .l-_
18 % HVAC R LS Company 50005 hWac
16 % Exteriors Linlirmited hiaterial 5.000 5 Lanascape

1. Hyperlink. Click the % iconto add a hyperlink to the resource. The icon “* means that this resource
is already accompanied by a hyperlink.

2. Resources can be added by pressing Enter, or from the context menu by applying the command Add
Resource.

3. Click the Type field of the Resource row. Add the resource type using the drop down menu. There are
five types of Resources in ConceptDraw PROJECT:

Work resources — People assigned to complete a task. Has a cost depending on the time unit.

Material resources — Consumables used as project proceeds. Has a cost per unit.

Cost resources — Financial cost associated with a task. Has a cost per unit and is applied to specify
the applicable cost, every time you use the resource.

Equipment resources - Technical equipment used to perform a task. Has a cost per unit and is applied
if the cost of the equipment used does not depend on the time units

Company resources — Cost associated with corporate resources assigned to a task. Has a cost per
unit and is applied to specify the applicable cost, every time you use the company resource.

4. Click the Cost field of the Resource row. Add cost value using the drop down menu. Cost of the Work
resources are those with a cost over time. Other types of resources hawe a fixed cost per unit.

5. Group. You can categorize project resources by groups. To add a group name, just click the field and
type it. The same resource can be engaged to several groups. Use the Resource panel for grouping.
Assigning a resource group to a task means assigning all resources included in this group in an equal
percentage. Grouping resources allows you to view and report summary information of resources and
assignments.

6. Columns that contains contact email and the additional resources information.
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7. Click the icon ™ to open the Work resource individual calendar. You can modify the common working
hour schedules individually for each employee.

Columns that contains the resources information can be managed using the Column Customization
dialog.

The width of a column can also be changed. For this set the cursor to the right edge of the column (the
cursor should turn a double-sided arrow) and drag it to the needed direction. Open Gantt Chart, View
select a task and assign resources to task using the Assign Resources panel. The information on the
resources can be edited in the Resource panel.

Resources Context Menu

Access the most frequently used operations with resources via the context menu.

MName Type Cost Group
Bob's Excavation Arial -9 = ||Excavation
Surveyor 1 A" A AB ab B ab k@ ~ [Surveyor
BakerFlooring Work 140 &/h Flooring
Surveyor 2 W Copy Surveyor
Excavator E E Paste Excavation
,}g Cut )
Truck E Excavation
= Add Res
Concrete mixer g™ a EeeureE Flooring
: B Delete Resource(s) :
Bob's Excavation s Excavation
iz Calendar...
Excavator E Excavation
Markers
Truck E EEPEEENEX Excavation
BakerFlooring Flooring
Concrete mixer Equipmert T00% Flooring
Resources List Context Menu
Arial |10 ~ Text Format Change the text format of the project schedule
A A B ab AB Ab & ~ Microreports Generate Microreports
B Copy Copy Copy the selection and put it into the Clipboard
I“ p : Cut Cut selection and put it into Clipboard.
g Faste Paste Paste content from the Clipboard
& Cut Add Resource Inserts new resource
= Besource Delete Resource(s) Delete selected resources
- - Calendar Opens the Standard Calendar dialog
Bk Delete Resource(s) Markers Set color markers
_‘ Calendar...
Markers

ERECEERENEX
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Multiproject Dashboard

ConceptDraw PROJECT lets you track multiple projects at the same time. The Multiproject View permits
the managing of multiple projects and a mutual resource pool from a single file. When you’ve got a multi-

project file, use the button } on the Home or View tab. It opens the Multiproject window. This window
contains a list of projects with their characteristics.

- i E] H =y | ;_-L|,,:;.:]_E [Coemmercial Construction_multiproject_new.cdpz - Multiproject

Home View Share Settings
B = - (i “ i

I a]

Paste Eh Wreap Text “ A  Solutions Gantt Resources Multiproject Resource Reports  Microreports Add
Chart Usage - -
mat Text Select View Micrarepons E General
@ varter 2023 4th Quarter 2023 1st Quarter 2024
# Project Mams Start Date Finish Date B
;-\I.I:g Sep Oct Haow Dec Jan Feb
|
1 E{onsuuctim 8712023 111512023 615 L . 0% N
|
]
2 % Construction Project B/7/2023 10172023 245, (N 0% ™ JohnSmith
|
E& Site Arrangement 8M72023 111512023 3704 I 0 W TomBrown
4 A B Renovation 71282023 11/10/2023 430, e————— )y W
|
5%  LeaseaMNewFacility 81472023 111012023 2501 I 0 W TomGrown
|

6 Kitchen Renovation Tr28/2023 1122023 180, NN ":: B JohnSmith
|

1. Projects can be added to the document with one of the following methods:
By pressing Enter

Using the General section on the Home tab

Applying the command Insert New Task from the context menu.

2. Columns that contains information on the multiple project can be managed using the Column
Customization dialog.

The width of a column can also be changed. For this set the cursor to the right edge of the column (the
cursor should turn a double-sided arrow) and drag it to the needed direction.

3. You can set the visual parameters of the multiple project Gantt chart using the Multiproject Settings
tab.

4. The timescale can be changed. This can be done in the Timescale dialog, that can be accessed from
the context menu.

Also can change the task start/end date, its duration and completion . To change start/end dates move
the bar by your mouse. To change the task duration you need to switch to Gantt Chart view.

5. Project Group treats each project similarly to a phase, so all the properties are aggregated from the
projects you include. Please note that Project Group only groups projects, so it does not have its own
tasks. You can group projects using the context menu . You can then select a project and use the
Group Projects command from the context menu or create a New Project Group where you can then
move your projects to.
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Multiproject Context Menu

Access the most frequently used operations at Multiproject window via the context menu.

= Project Name Prionty
1 % B Construction aaeoao
2% ConstructionProject | 00 0
3% Site Arrangement [ A ]
4 * © Renovation [N ]
5 Lease aMewFacility 000
[ Kitchen Renaovation fannn

Multiproject Context Menu
Text Format
Microreports

Arial =1 -
A A AB ab AR ab & -
Yiew Gantt Chart

==, DMew Project
Mew Project Group
=, Insert project from file...
=
Group projects
Ungroup projects
Create MINDMAP File
3 Delete Project(s)
Projects Link
Add Text Box
Markers

EEOEEENEX

Start Date Finish Date
7212022 111172022
Tr22022 10/6/2022
8152022 11112022
919/2022 111/2023
101372022 1111/2023
919/2022 12282022

View Gantt Chart
New Project

New Project Group

2
3

3

2
1

Arial

A A AB ab AE ab
580,880 §

-
-

=

Markers

EEDEEENEX

4th Quarter 2022 1st Quarter 2023

p Oct Niw Dec Jan Feb

JohnSmith
Tom Brown

Insert project from file... N
[ ——
I /ohn Smith

Mew Praject

New Project Group

Add Subproject

Group projects

Ungroup projects

Create MINDMAP File
Delete Project(s)

Projects Link )

Add Text Box

Change the text format of the project schedule

Generate Microreports

Insert project from file

Add Subproject
Group Projects
Ungroup Projects
Create Mind Map

Delete Project (s)
Project Link Link
Add Text Box
Markers

Switch to Gantt Chart View

Add a new project

Add new project group

Add a new project from file

Add sub project to selected project

Join selected projects into a Project Group
Split the Project Group into separate projects
Generate a multipage mind map (*. cdmz) from
selected projects. The file will be opened in
ConceptDraw MINDMAP

Delete selected project (s)

Link two or more selected projects

Add a text box to selected item

Make the selected items looking like marked
with a highlighter
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Multiproject Timescale Context Menu

#, ZoomIn cl==  Zoom In Displays timescale in more detail (day instead of weeks, etc.)
=, Zoom Qut Cerl+- Zoom out Displays a more generalized timescale (weeks instead of days,
Wt Timescale.., Ctrl+Al+T etC.)

B Calendar.. Timescale Calls Timescale dialog that allows to customize timescale

appearance. It gives more possibilities for this than Zoom In and
Zoom Out commands. On the other hand mentioned commands
allows to change calendar scale quicker.

Calendar Opens the Standard Calendar dialog

Multiproject Settings
You can change the visual parameters of the Multiproject View

BriEn~an =T
“ Home View Share Settings
¥| Planned Complete Select tracking penod T ]
|
¥| Complete Change Value '
Tasks
¥| Complete Change Rate Completion
# Project Mame Start Date Finish Dabe
1 ¥ B Construction 872023 1115/2023
2% Construction Froject BITr2023 101712023
3% Site Arrangement BMTR0Z3 11162023
Show/hide
Planned Show/hide the planned complete mark on Maw Jan Feb hhar Apr

complete the project Gantt chart 50 Brad Pitt
100% 3% Richard Miller

‘ mlj Marﬂrﬁniams

Complete Show/hide the change of the complete value Mow Mar Lpr

change value :i 50 % Brad Pitt

ﬁ M Richard Miller

‘ |Ij m = Maw\*llllams
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Complete
change rate

Tracking
period

Task
Completion

Show/hide the symbol of the complete
change rate.

Mo Dec Jan Fek hdar Aar

l::i SU%D Brad Pitt

Project’s dynamics are shown using colored
symbols:

* yellow arrows indicate a normal
completion level

 green arrows means that a project is
ahead of schedule

* orange square symbol signals that the
project’s completion didn’t change, the
project “sleeps” and we have zero progress.

Select tracking period
Set the frequency of complete values
verification

Show/hide the colored bar representing the
situation with the completeness of the
project’s tasks. You can see the number of
completed

tasks, the ones in the process, and those
that

have not been started.

Iﬁ 100% [ 299 ] Richard Mitier

‘ |Ij 0% Mary Williams

s Day
Week
Month
Quarter
Half year

Year

B JohnSmith
I EETE| Tom Erown
I T onn Smith
IETI| Tom Erown
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Resource Usage

By clicking the button = on the View tab, you open the Resource Usage window.

Resource Usage diagram consists of two parts: the task list and graphic presentation of the tasks.

Hama

E Bob's Excavation
Cleanng and Sie Grading
Excavabon
Concrete Pilas
Brick
Yenling
Design prowies Conginiciion
Design prowies Conginiciion

B Surveyor 1
Stake hves and grades
Footindgs

5 Baker Flooring
Spraad Footings
Walls
Install Healpumps
Telephone, Secunty, and Electrical
Diesign prevides Consinachon

Prgject N

Canstruction
Canstruction
Canstruction
Canstruction
Construction
Lease a New Facilty

Site Asrangemant

Canstruction
Canstruction

Canstruction
Construction
Consinuction
Canstruction

Lease 3 New Facilty

— w7, 10 Sap 2023 w3, 17 Sep 2023
o 05 OF O Lk ] W oW N n =
148,600 5 N DN e [ [
24 000 5 100% 100%
25600 5
16,000 § 100% 0%
40,000 5 100% 100
8,000 5 100%
17600 5 100% 100%. 100%
17,600 5 100% s
18,200 § 100
5,000 5
11,200 § 10
844805  con N  — . — [ e R |
19,200 § 100% 100
19,200 § 100% 100%
19,200 § 100% 100% 100%
12,800 § 160% 100% 100%
14,050 5 100% 0% 100%

It is a kind of a Gantt Chart which shows you all resources with their usage by tasks and money.
1. You can find out which projects resources are used in, what tasks are assigned to them, and finally,

how much it costs.

2. To quickly mowe to the Resource view just make double-click on a resource name.
3. To mowe to the Gantt chart view make a double-click on a task name.

4. The graphic part of the diagram displays tasks as bars. Bars are arranged in accordance with the
Timescale, displaying the task start /end time, duration, and percentage of resource working time

occupied on a task.

5. If the total resource load currently exceeds 100%, the resource chart bar will show it with a red color.
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Filters Mode

The embedded filters of ConceptDraw PROJECT can be very useful for viewing a specific range of

information. You can apply filters to tasks, resources and even projects.

Filters mode can be activated from the Filters section on the View tab.

1. Select one of the embedded filters from the drop-down menu.

sl B-Ealsl R}

Home View Share

=] LT

- . ‘5

Gantt Resources Multiproject F!t‘.oun:t Reports
Chart Usage

Filter Mode: Milestones

ZH /] Tm

Out

mescae

? Your changes are not fitered unt you press Refiter button @

L] Hame

1 ¥ Construction Contract Award 1

2

% Accept Site
1% %

Extenor Tnm

wa ]

Prionty
(11
(LN

(B ]
'l Bl

| 872023
| 8142023

| 8232023
e

T.m:l:ne Scale  Expand Collapse
| |

"l_'j:'mn
8/14/2023

[Commencial Construction_multiproject_new.cdpz - €

T Malestones = Xg
Show Phases || Show/Highlight
October 2023

wiT w3 wid Wil wd

L Y

2. Toggle Show/Highlight item, to highlight filtered items without hiding the other data.

C Isl N-EakeX 1%

[Commercial Construction_multiproject_new.cdpes - Ge

Home View Share
—_— oo = B~ B o e
- . s Q=M == Viietones |28 X &
Gantt Fesources Multsproject F:H:un:e Reports In Out Timeline Scale  Expand Collapse Show Phas
Chart Uiage - All All
Sebect View Tureticaie % Evpard ol apne Filters I
Filter Mode: Milestones
? Yeour changes are not fitered untl you press Refizer button E
Aupuat 12} Seotesber 2013 Octobs
g Pricdy Sart Wil wid wil wii s il f‘!? wil wi ]
1% Construction Contract Award 1 1 2023
2 % AcceptSite 1 811472023
3 ¥ Stake lines and grades 00000 8282023 Surveyor 1
4 ¥ Clearing and Site Grading 10000 92023 Boby's Exce
5 ¥ nilities BRB00 9132023
& % Excavation 00000 a2 | ———— Boly's Excavation [ 100 %); Excr
7 % B Fovndstion and Rackdill BRRND a3 "

3. Toggle Show Phases item to display phases that are associated with tasks which are shown in the

filtered view.

ConceptDraw PROJECT User Interface Reference

© 2024 CS Odessa corp.
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. B ' wEkalnl 1§ 3 [Commercial Construction_multiproject_new.cdpz - G-
Home View Share
[ T o- ] L— = e = - I T — )
= IS Qg TM Z=1F T 02 Tans  exa
Gantt Resources Multiproject Resource Reports In Out Timeline 5Scale  Expand Collapse Expa pse Qutline | (&) Show Phases][ | Shaw/Highlight
Chart Usage . All All Level =
Salect View Timescsis fa Expand/Collapss Filters [
Filter Mode: Milestones
? Your changes are not fitered untl you press Refiter button Izl
August 2023 September 2023 Octr
# Hame L st w3l w32 w33 wid w3k w3E wW3T w3l w39 Wl
1 % Construction Contract Award 1 peR00  s72023 &l_i?fzﬂﬁ
% AcceptSite BOR00 8142023 81412023
13 % = Exterior Wall Surfaces BON00 232023 v 1
15 % Extenor Tam BOR00  sr2¥2023 * 812372023
18 % Panrlhcsrgd= BARND  armdiyy * QNI Serpprinr ?

ConceptDraw PROJECT User Interface Reference © 2024 CS Odessa corp.
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4. You can reverse filtering condition using Invert button.

BOTHY~@R

[Commercial Construction_multiproject_new.cdpz - Ga

“ Home View Share
[ T - o] i O O e Ce— g r— . )
= M L= R H— 4T - -
- ey E — !jJ @'l Q = m, o= = = [ I= Y Milestones = o G
Gantt Resources Multiproject Resource Reports Ins Qut Timeline Scale  Expand Collapse Outline  [7] Show Phases Shiow/ Highlight
rt Usage - All All Level™
Salpct View Timescais H Expand/Collagse Fitters n
Filter Mode: Milestones
? Your changes are not filtered untl you press Refiter button @
- — =z e Seplember 2023 Oclober 2023 i
Ll
) w3k w3 w37 wid w3d wil wdl waZ wdd Wil
3 ¥ Stake lines and grades BRR00 a/2802023 Survayer 1
4 % Clearing and Site Grading pee00 942023 Bob's Excavalion Excavator [1]
- Surveyor 2

5 % Utilities 10000 9132023

& ¥ Excavation 614/2023  —

Ba

7 ¥ B Tny Aap om ol Pack™ garapm

¥'s Excavation [ 100 %], Excavator [ 1]

=
5. Use the Refilter button ¥ to reapply the filter when you have made changes in the project

schedule.

6. To remowe the filter, click on the Clear Filter button.

T|Mi|e5tu:ur1e5 '|4 X h‘

Show phases [ | Show/Highlight

Filters ]

You can customize the filtering options using the Eilters dialog

ConceptDraw PROJECT User Interface Reference

© 2024 CS Odessa corp.
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Critical Path

Critical Path Analysis helps identify the minimum length of time needed to complete a project. When you
need to run an accelerated project, the critical path will help you identify which project steps you should
accelerate to complete the project within the available time. Select the Gantt Chart View or Multiproject
View and check the Critical path option on the View toolbar. The critical path will be highlighted with the
red color.

The critical path of a single project shows which tasks are most critical: the ones that add up to the
longest project duration.

[ NsSN N-Kalal B % [Commercial Construction_multiproject_new.cdpz - Gantt Chart] - ConceptDraw PROJECT

“ Home View Share

— & — = - — B . ., [r— —
- 6} E‘ = EJ Q Q = R - 1 = Trofite h 0 | | C—
= — = H— | -| [ Assigned Resource
Gantt | Resources Multiproject Resource Reports  In Out Timeline Scale  Expand Collapse Outline * _i — ~
Chart Usage . P Level ™ - Show Text Boxes
Select View Timescake [ Expand/Collapse Filters - hemes Shovw/Hide
August 2023 September 2023 October 2023
o o s frsh ComPI® g w30 w3 w2 wEd wM W wiS Wl w3 wi9 wad  wdl w2 wel
2 % Accept Site BIGI2023 0% BI6/2023
3 %  Stake lines and grades BI26/2023 WBr2023 100 %
4 % Cleanng and Site Grading W42023 H2VZ023 67 %
5 % Utilities 1112023 1071372023 100 %
6 % Excavation 81472023 42023 100 %
7 % B Foundation and Backfill WAI2023 AN1N2023 32% ‘
8% Footings Q82023 100502023 0%
8 % Spread Footings 1412023 Q22023 53 %
10 % Concrete Piles 911112023 222023 30 %
1| % Slab on Grade Br25/2023 Q2612023 100 %
12 % Walls W25I2023 1071372023 3%
13 % B Exterior Wall Surfaces w2120 22023 40 %

The critical path of a multiple project shows which projects are most critical to complete all the projects
on time.

- IsN B=Ealsl R T I al C _multipraject_new.cdpz - Multipreject Dash )- € PROJECT
Home View Share Settings
S S I - B Bm== N g e . | [ — ) —— '
—_— G S H @ TMmM === =T Hofi - 5| ] —)
Gantt A j Repots I Out Timeline Scale  Expand Collapse Outline i —h_ ot —
Chart Usage - All All Level™ ¥| Show Text Boxes
Select View Timescale 2 Expand/Collspse [ . ShowHide
e 203 3rd Quarter 2023 4th Quuarter 2023 15t Quarter 2024 2nd Quartes 2024
] Project Name Start Date Finish Date Budge Company
May Jun Jul Aug Sep Oet Mew Dec Jan Feb Mar Apr May
1 % E Construction 71302023 11152023 6158805 —_
2% Construction Project 73072023 10132023 2458805 ABCConstruction I T ohn Smith
3% Site Arrangement TR0z 111502023 3700005 Constructor Lid I ETE TorErown
4 % E Renovation TIZBROZI 11102023 430,000% P——
5% Lease aNew Facility 81472023 11102023 2500005 Constructor Lid Tom Brown
B ¥ Kitehen Renovation 71282023 111212023 1800005 ABC Construction m Jahn Srith
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Share

. A n H "y A = [Commercial Construction_multiproject_new.cdpz - Gantt Chart] - ConceptDraw PROJECT

Home View Share

]} oo -fh ] m 1
o o @ 2 K @ a [
Capture Images MS DIAGRAM  Open in Adobe MS MSs Mindjet Text

Shde~ PowerPoint - MINDMAP PDF  Excel™ Project MindManager Qutline
Presentation ConceptDraw Exports

il

Presentation

I
=] Capture Slides
i |=| Visible area
= Whole view
ConceptDraw PROJECT allows you to make slides for presentation. You can
create slides from any of project views.
Make slide from the current project view according to chosen option. The slides
will appear in the pop-up Slide Preview panel.
o Images: Sawe slides in PNG format.
=
o

@ MS PowerPoint: Save slides as MS PowerPoint presentation (PPTX).

ConceptDraw
DIAGRAM: Create a Project Management diagram in ConceptDraw DIAGRAM
Open in MINDMAP: Open the current document in ConceptDraw MINDMAP ,
having closed it in ConceptDraw PROJECT.

Exports

Adobe PDF: Export the document to Adobe PDF.

MS Excel: Options for Export project tables, as they appear in View mode, to a
Microsoft Excel workbook (XLSX).
MS Project: Export the document to Microsoft Project XML.

= i <)
I._._.:I L

Mindjet MaindManager: Save the document in Mindjet MindManager format
(MMAP).
Text Outline: Export the document to text outline.

X

il
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DIAGRAM

Project management diagrams give you the ability to view at a detailed level project attributes such as
project scope, logical connections in the project, critical paths, key events on the timeline, milestones,
tasks, calendars for work, and resource utilization. Transforming project data into different visual forms is
a productive way of looking at your project from different perspectives. It also helps you deliver project
information in suitable way depending on your objectives and audience.

. M ' H "y A B [Commercial Construction_multiproject_new.cdpz - Gantt Chart] - ConceptDraw PROJECT

Home View Share
o o o ] | T
=& @ | 2n|¥€ Boea O

il

Capture Images M5 DIAGRAM| Open in Adobe M5 M5 Mindjet Text
Slide™ PowerPoint PMINDMAP PDF  Excel™ Project MindManager Qutline
Presentation ConceptDraw Exports

Select the proper diagram type from the drop-down list of the DIAGRAM button on the Share tab. There
are 10 types of visual project diagrams available: Gantt Chart, Milestones chart, PERT chart, Radial
Structure chart, Resource Calendar, Resource Usage diagram ,Timeline, Timeline From Marked Tasks ,
and WBS chart. The diagram will be generated and opened in ConceptDraw DIAGRAM.

Project Management Diagrams

Gantt Chart Milestone Chart

Create Gantt chart diagram from Show only linked milestones
projects tasks with an outline level

equal or less than two

Milestone Chart Extended ENEEEEEEE PERT Chart

Show all milestones Create Project Evaluation and
Review Technique diagram from
projects tasks

Radial Tasks Structure Resource Calendar

Create Radial Tasks Structure chart Create project calendars for

from projects tasks to show the — —==== resources assigned to projects tasks
volume of work

©m

Timeline

Create Timeline diagram from
project tasks with an cutline level
equal or less than two

= Timeline From Marked Tasks WES
L - Create Timeline diagram from égé Create Work Breakdown Structure

—h projects tasks with marking option diagram from projects tasks

Resource Usage
Create Resource Usage diagrams for
resources assigned to projects tasks
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MINDMAP

. i . H [a) a R [Commercial Construction_multiproject_new.cdpz - Gantt Chart] - ConceptDraw PROJECT

Home View Share
o o o ] b mal T
= = 2oa O
o @ 2f| = H
Capture Images M5 DIAGRA| Open in Adobe M5 M5 Mindjet Text
Slide™ PowerPoint - PAINDIAP PDF  Excel™ Project MindManager Qutline

Presentation ConceptDraw Exports
The compatibility between ConceptDraw products allows you to migrate your documents from MINDMAP
to PROJECT and vise versa. You can see the project data in a mind map structure by opening your
project in ConceptDraw MINDMAP. Mind map will consist from topics of Project Management type,
which contain all project information. Project Notes will be opened as Notes to topics. All hyperlinks will
be displayed in the Hypernote panel. This way you are switching views without creating extra files. You
can see the same file in both applications:

il

ConceptDraw PROJECT

Tl =Ladal 1% [rerrrrer R p———
[ -
ﬁ Kia  nam oz = E EE E.l
h B 4 A A D =
. ay e e - o
o 0D Asn wa BER Yaema A
Py AustPunnng 24 00000 STMRY | S23IOR
SV 0 Rt At Ba NENDT S30me23  BATeR
B =
+%  Cashand Equwalenss WINDS 5302020 [— -~
WY Accounts Recorvatie Jd NNN0G 590 | e — 0
B Wwenios 5000000 SI0M@Y  6ST0R - 1T
T Peepad Expenne WIS 5200
PR . T ] P —
¥ s SO NTY Y (1] S £l
W% Acounts Payble 2400000 WIOME SRR e ]
" vt Cusmerd d 0ii Lo e | S0 Y £
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Share MS Excel
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MS Excel

. i ' H a2 le . B [Commercial Construction_multiproject_new.cdpz - Gantt Chart] - ConceptDraw PROJECT

Home View Share
S8 & n ¥ Baoewm O

Capture Images M5 DIAGRAM  Open in Adob M5 M5 Mindjet Text

Slide™ PowerPoint - MINDMAP PDF | Excel™ Project MindManager Qutline
Presentation ConceptDraw Exports

il

The drop-down list of export to MS Excel options contains two items:

1. Export tables from all views (also available from the File menu)

In this case, the Excel file will contain all the tables from the project file. The same function is available in
the Export section of the File menu under the Export to MS Excel item.

A B C D E F (=]
1 Name Start Finish Complete Cost Work
2 |Audit Planning 9/5/2023 9/6/2023 10% 2,800.00% 16h
3 |Preliminary Analysis 9/11/2023 0/12/2023 33% 4,400.00 § 24h
4 | Prepare Trial Balance 9/11/2023 9/12/2023 50 % 2,800.00 & 16h
Test of Transactions 9/11/2023 9/12/2023 50% 2,800.005 16h
S -
6 | Ratio Analysis 9/11/2023 9/11/2023 0% 1,600.00 $ gh

7 |Audit Activjties 9/13/2023 9/19/2023 0% 00% 168 h -
Multiproject Dashboard Audit - Gantt Chart | Resource Sheet | Resource Usage Sheet | ® i [d] 3
e 1 + 100%

2. Export table from the current view

In this case, the Excel file will contain a single table - the last one opened before going to the Share tab.
For example, to export the Resources Usage table to MS Excel, the following steps are required:

1. Open Resource usage view.

2. Go to the Share tab and select item 2 from the drop-down menu.

A B C D

1 Project Name Expenses
2 |Bob's Excavation 148,800 §
i i i Construction
Clearing and Site Grading ) 89,600 5
3 | Project
i Construction
Excavation ) 46,400 5
4 | Project
i Construction
Concrete Piles ) 64,000 5
3 | Project
i Construction
Brick ) 121,600 5
b | Project

Resource Usage Sheet )
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Edit Markers
Predecessors

Filters

Options

Document Properties
Find

Replace




Timescale

The Timescale dialog is called from the Timescale group of the View ribbon.
Use it to determine the time measure units for tasks in your document.

Timescale >
Top Tier Formatting

Units: | Weeks - Align: | Left e
Bottom Tier Formatting

Units: | Days o Align: | Center w

Carcal

Units - Specify units from units list for large and small scales on Timescale gauge.

Align - Specify text alignment on timescale.
Count - Specify units interval.

39
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Column Customization

Customize columns dialog can be accessed from View tab
View and edit information to be displayed at the project outline.

Column Customization >
Column 2 ILI
Mame
Priority
Start
Finish cclect Al
Complete
Cost v | | Deselect Al

The Column Customization dialog contains the following columns:

Gantt Chart View

Baseline Cost Total planned cost for an task
Baseline Finish The planned completion date for a task.
Baseline Start The planned beginning date for a task.

The current status of task in percentages of the task’s

Complete duration that has been completed.

Cost The total scheduled cost for a task

The piece of total scheduled cost that remains for a task

Cost to Completion .
lcompletion.

The custom column, user can use to enter any additional

Cost1 linformation on the task cost

CP Tasks, marked in this column make a project's critical path.

ConceptDraw PROJECT User Interface Reference © 2024 CS Odessa corp.
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Custom Mark Indicates tasks marked to be used in the Timeline from
IMarked Tasks report.
Custom 1-10 Adc_lltlonal specific information important for a particular
Iproject added by user.
. The target data, indicates when the task should be
Deadline
{completed
Duration The total span of a working time for a task
Early Finish The earliest date that a task could possibly be completed.
Early Slack The duration between the Early Start and Early Finish Dates
Early Start The earliest date that a task could possibly begin.
Finish The date when a task is scheduled to be completed
Hyperlinks Add/Edit hyperlinks to a task
. The latest date that a task can finish without delaying the
Late Finish . .
{finish of the project.
Late Slack The duration between the Late Start and Late FinishDates
Late Start Th.e latest date .that a task can start without delaying the
{finish of the project.
Name |Project task name
Notes IComment you can enter about the current project
Outline Level |Displays the place of task in the project outline hierarchy.
Outline Number The number thgt dls_plays the associated task’s position in
Ithe project outline hierarchy.

ConceptDraw PROJECT User Interface Reference © 2024 CS Odessa corp.
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The planned task completion status (percentages) at the

Planned Complete lcurrent date.

The tasks numbers (#) on which the task depends before it

Predecessors ican be started or finished.

Priority The level of importance given to a task by project manager
Resources IResources assigned to task

Start The date when a task is scheduled to be started

The tasks numbers (#) that act as successors for the current
Successors task (tasks, whose start or finish date is driven by their
predecessor task.)

The total amount of time , scheduled on a task for all

Work assigned resources., or the total amount of time , scheduled
ffor_particular resource on a task (Assign Resource panel)
The Unique ID field contains the number that ConceptDraw

Unique ID PROJECT automatically designates whenever a new task is
created in the current project.

Multiproject View

Baseline Cost Total planned cost for a project

Baseline Finish The planned completion date for a project

Baseline Start The planned beginning date for a project.

Budget The budget, allocated to a project.

Company {Company Name

Complete The c_urrent status of project in percentages of the project’s
duration that has been completed.

Changing of the Complete value between the current and

Complete Increase ) .
previously saved measured in percent

ConceptDraw PROJECT User Interface Reference © 2024 CS Odessa corp.
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Complete Increase Rate

Changing of the Complete Increase value between the
current and previously saved measured in percent

Cost

The total scheduled cost for a project

Cost to Completion

The piece of total scheduled cost that remains for a project
{completion

Duration The total span of a working time for a task

Finish Date The date when a project is scheduled to be completed
Hyperlinks Add/Edit hyperlinks to a project

Objective |Project objectives

Planned Complete

The planned project completion status (percentages) at the
lcurrent date.

Priority

The level of importance given to a project by project manager

Project Description

Short description of the project

Project Manager

Who is project Manager?

Project Name

|Project name

Project Site

{Url of the corresponding website

Start Date

The date when a project is scheduled to be started

Resources View

Cost

For Work resource displays the cost that accrues every time
unit, the resource is used.
For a non-human resource displays the cost that accrues at

one unit of the resource usage.

ConceptDraw PROJECT User Interface Reference
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Email |Contact email address assigned to resource
Group A customizable field to structure resources into groups
Hyperlinks Add/Edit hyperlinks to a resource
Name IResource name
Notes {Comment you can enter about the current resource
Tvoe Type of the resource (work, material, cost, equipment,
yp lcompany)
The Unique ID field contains the number that ConceptDraw
Unique ID PROJECT automatically designates whenever a new
resource is created in the current project.

ConceptDraw PROJECT User Interface Reference © 2024 CS Odessa corp.
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Edit Markers

Use the Edit markers dialog to set names for Markers. Just click a marker and start typing.

x

Edit markers

| Orange marker
| Yellow marker

ConceptDraw PROJECT User Interface Reference © 2024 CS Odessa corp.
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Predecessors
Predecessors dialog can be accessed from the Link section in the Home tab.

Once you have created a list of project tasks, you need to edit your project schedule in more detail by
moving tasks, setting dependences between project tasks, or making other changes using the Home tab
tools. For example: you have tasks that you would like to link together. But, also you need to add lag
time between 2 tasks.

You can make this using the Predecessors dialog.

. e ] Fhen w37, 10Sep 2023 w38, 17 Sep 2023
07 08 09 10 11 12 13 14 15 18 17 18 19 20 7 2
1 % B Audit 52023 2572023
2% Audit Planning 9512023 9/6/2023 Kathrine Smith
3% B Preliminary Analysis 91112023 142023 F—_
4% El Prepare Trial Balance 91112023 SA2023 fr—
5 ¥ Test of Transactions 91172023 9122023 Kmﬁerine Smith
6% Ratio Analysis M42023 91412023 r Denise Maorston
7Y EHAuditACt pogecessars x || !
8% Cash Ste o 9I15/2023
9 ¥ Accoun Delete Mew ' Dénise
10 % Invento 4
11 % Prepaic Link Fom Type =2 -"1 9152023
2% Propert 4 - Testof Transactions Start to Start 3d "’1 9152023
13 % Other A Lee 91502023
14 % Accoun w r Sto
15 % Other C - E—
16 % Incoms -;_1—
17 % Long-te -4"-. 9/15/2023
18 ¥ Stockhs _ ¥15/2023
19 % Revenu
0 ¥ Subseque
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Filters

Those who use ConceptDraw PROJECT in their daily work may have faced the need to filter their project
in some special way to get the appropriate information. To customize filtering options use the Filters
dialog that can be accessed from Edit Filter button in the Eilters section on the View tab.

In the left part of the window, you can specify the project view, which is filtered by default. There is also
the filters list which contains predefined and user created filtering options.

Filters

Filters for: |Tasks w

T

Active Tasks - |

Baselne Finish Violaton

Basaina Stk Violaton

Camplate Range.,.

Compleied Tasks

Cost Greater Than, ..

Cost Crverbudget

Critical

Dite Range..

Tregpengle berd Tarshos

Inoomple ted Tasis Using Resou

Late Cribcal Tasis

Late Tagks

Miesiones

Phases

Task Range...

Tacks With Desdines

Tasks Wish Mane.,,

Tasks With Qreeralocated Rese

Top Lewel Tasks W
b

b s i Tﬁ'.

ame: | Aine Tasks

Description | Shaw tadks that have been staeted but not complebed yeb,

Ect Editcplumn

Calurn T iabd Tast Vialug
Comples Mo dows not egul 100
canrt Mo i5 less than or sl i
Finizh Mo I5 greater than or gl i HA

Thes flter s standard and nonedSable. Tou can onfy duplbcate it

Filters far: [Tasks

-

==

Ecidvake

wake labd Relazen
He
Hiz
i and
I

Filters for: Specify the project view, which is filtered by default: Project, Tasks, or Resources.

Available Filters List: The filters list which contains predefined and custom filters.

1|

Active Tasks
Baseline Finish Violation
Baseline Start Violation

Complete Ranae...
Incompleted Tasks

=+

m

Incompleted Tasks Lsing Resou
Tasks With Overallocated Resoll

Top Level Tasks
|Unstarted Tasks

1] [

Y. Add Filter: Add new custom filtering conditions.

t. Remove Filter: Remowe the selected filters.
*The predefined filtering options cannot be edited or removed.
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TTDupIicate Filter: Duplicate the selected filters. If you need to modify predefined filter, you should
duplicate this filter by clicking “Duplicate filter”

i
E] Add/Remove criterion row: Edit custom filter using editing window

Filters

Filters for: |Tasks w Hame: | ohn Smith cempieted tasks

Active Tagks | Desoroton: | Show John Smits tasks compieted by 100%
Bacabne Frich Violaton Y

Bacsaine Start Violaton

Compiate RBNge... Eot Editcomn == Ecidvake
C ed Tasks Calurn T {abd Test Valug = b Relasan
Cost Greater Than, ..

Complee Ha uais 100 Ho
Cost Overbudget E -

Critisal =11 Mo i5 gremler iRan o s Stari He angd

st Rangs... Finih Ha I% less than or sgqual o Eiresh Ho and

Tregpengle berd Tarshcs Refounces Ha conrs Jahn S Ve ang

Irvcoemple ted Tasis Using Resou

John Smith completed tades

Late Critical Tasks

Lane Tasks

Hilesiones

Fhases

Task Fargs...

Tasks \Wigh Dendines

Tashs With Bame.., .

Tasks With Overalocated Resm v . .
L4 » =

EIEIF T T [ 1 conl

*The predefined filtering options cannot be edited or removed.

T Export Filter to File: This operation allows exporting selected custom filters into single XML file
and copying it to other computer.

«lz Import Filter from File: This operation allows importing your custom filters from XML file. Thus,
the filters will be available on any computer no matter which ConceptDraw PROJECT document you
work with.

Filter Mode: John Smith completed tasks

?:.‘ohnSmiﬂ'l @

1 Mar 2018 wi2, 18 Mar 2018 w13, 25 Mar 2018
& Name Prioy | Gomplete — ; " . — ; . .
| ”IZ 13 |14 156 | 16 ‘n_? 18 |19 | 20 | 21 |22 (23 (24 |25 |26 |27 | 28 |29 | W0
3% Specification et 100 % e John Smith
5%  PERT diagram 100 % @ 3/16/2018; John Smith [ 50 %]; Linda Rice [ 50 %]

wi'? Database architecture e 100 % John Smith; Alexander Miller
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Options

Can be accessed from the File tab. Contains options preferences related to the most commonly used

settings
General

Concaptlnps FRONCT sptions

Curercy pwmtet: | §

Curercy poatore | § 1,33

Siecmal dgts:

Schedule

ey PROICT sptizne

Display on a new document: Set up document default
view
Color scheme: Set up document color scheme
New document view settings: Set up new document
view (custom or default)
Currency symbol: Set up currency symbol
Currency position: Select currency position
Decimal digits: Set up amount of decimal digits
Behaviour: On/Off the Smart Enter mode
On/Off the deadline Mircoreports automatic
generation

Calendars:

Working week days: Set up working week days.

Default working time: Set up default schedule. Schedule
is presented as set of daily working time intervals.

Work units:

Week starts on: Select week start.

Hours per day: Set up working hours amount per day.
Hours per week: Set up working hours amount per
week.

Day per month: Set up working days amount per month.

Scheduling:

Default task type: Choose what you would like to fix:
Units, Duration or Work

Default task duration: Set up a task duration on default
Default task start date : Set up a default start date of the
new task

Effort - driven check box: Set up the effort-driven options
for the new tasks

Read more how to use the Effort-Driven Scheduling
Method



https://www.conceptdraw.com/helpdesk/how-to-use-the-effort-driven-scheduling
https://www.conceptdraw.com/helpdesk/how-to-use-the-effort-driven-scheduling

Autosave

Concaptlnps FRONCT options
tereal

Aoz ptions

Sehedie

£ 1
e

Cancal

Autosave:

Switch on/of autosave
Every:

Set up autosave periodicity

50
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Document Properties

View and Edit current document properties. Document properties dialog is available from the File ribbon.
It contains three tabs: General, Calendar and Advanced.

General tab allows to set the starting points of project calculations : Currency and Work units.

Document Fropertses x

Canersl  Csbenclar  Advanoed

Curency
Crrency symbol; | § w
Curmency poditers: § L.73 w
Diecinal dhyts: | 1 =

Wi Urits

Hours per day: |
Howrs per weeln | 3

Doyl por month: | 20

CACIR BN

o ]| conen Ay

Calendar tab is used to customize the default project calendar. You can set up schedule for all
resources in your project.

Select resource from the drop-down list to create a Work resource personal schedule. Selects set of
dates to do this. Set up schedule to selected dates. Schedule is presented as set of daily working time
intervals. You can set the selected dates as non-working.

Documert Properiies i Document Propednes =
General  Coendesr  Adwanoed Goneral Calsnds’  Advanied
Satings for calendar ST or e
Wiorispace Calendar ~ | Reset o defail |~ ierkapace Caleralar = | Reset todefplt | v
vaorking bime: John Smih prkinyg teme:
i - el tha firgren
Su Mo Tu We Th Fr Sa [ armerioreg Aeancier biler T
Linc fce
Fromi Te R Ta
LR 1500 q % 5 LR L300
= e - 3 i
RN S 1400 1800 ) il 1400 12:00
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Advanced tab allows to set the critical path and critical task parameters.
Document Propenties *

Genersl Caencsr  Advanced

Critical Pashy

ECakninte ritpmndiern crimeal path for ach projest

Task i critenl if slack i lets ®un or egual o: | ) I: v
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Find

This dialog allows you to search for text in a project schedule. You can call the dialog from the Home

tab button ﬂ

The Find dialog:

Find and Replace =
Find Replace
Find what: | |
Look in column: | All Columns o
[ Match caze
Find Previous Close
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Replace

This dialog allows you to replace text in a project schedule. You can call the dialog from the View tab

button

The Replace dialog:

Find and Replace

Find Replace

Find what: | | |

Replace with: | |

Look in column: | All Columns

[ ] Match case

Replace All Find Previous Find Mext Close
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Floating Panels

Some tools and features in ConceptDraw PROJECT are accessible from the floating panels. Floating
panels can be accessed from the drop down list of the Panels button on the View tab.

Bosrnoren [Software Development Alpha-r.cdpz - Gantt Chart] - ConceptDraw PROJECT - o
e v s Ho-
- fm @ o= 8 . Crteatpath = e =
= [ @& - L [r—| | — | — =
- @‘ - =¥ A — — - * | [ Assigned Resources 04
In —— | — i s

Gantt Resources Multiproject Resource Reports
Usage

Chart ¥ Show Text Boxes

Baseline  Select

¥ Project
Resource

Assign Resource

Task

Project

Resource

Assign Resources
Solutions

Slide Navigator

Hypernote
Links
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Task

Task dialog can be accessed from Panels button on the View tab.
Task dialog defines the project parameters and allows you to manage a task information from the Gantt

chart,

Name: Set up task name.

— S Duration: Set up task duration.
R B— Measuring unit: Specify duration measuring unit.
I Complete: Set up percentage of completeness.

el = : Milestone: Convert task to milestone.
: Priority: Set up task priority.

Marker: Specify task marker from list.

Baseline: Display task baseline cost.

Start:

: R Actual: Display task actual cost.
= Start: Set up start date.
"""" e — Finish: Set up finish date.

Deadline: Set up deadline date.
Scheduling: Set the Fixed Task Type
Effort driven: On/Off the Effort-Driven scheduling.

Task types: You can Split a task, or create a Recurring task.

The three Task Types used in ConceptDraw PROJECT are Fixed Units, Fixed Work, and Fixed
Duration. Fixed Units is set as default.

Each of the task types affects scheduling when you edit one of the three elements as follows.

Task type Units is edited Duration is edited |Work is edited
Fixed Units Duration is recalculated [Work is recalculated |Duration is recalculated
Fixed Work Duration is recalculated [Units are recalculated |Duration is recalculated

Fixed Duration |Work is recalculated Work is recalculated |Units are recalculated
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Effort - Driven Task

Effort-driven scheduling is the default scheduling method used in ConceptDraw PROJECT . The duration
of a task shortens or lengthens as resources were added or removed from a task, while the amount of
effort necessary to complete a task remains unchanged. Effort-driven scheduling only takes effect when
resources are added to or removed from a task.

Effort-driven calculation rules are not applied when you change work, duration, and unit values for
resources already assigned to a task.

When working with effort-driven scheduling, keep the following in mind:

The effort-driven calculations apply only after the first resources are initially assigned to the task.
After the first resources are assigned, the work value doesn't change as new resources are assigned
to or removed from the same task.

If the assigned task type is Fixed Units, assigning additional resources shortens the duration of the
task;

If the assigned task type is Fixed Duration, assigning additional resources decreases the individual
unit values for resources;

If the assigned task type is Fixed Work, assigning additional resources shortens the duration of the
task.
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Split a Task
When you need to interrupt work on a task, you can split the task so that part of it starts later in the
schedule. You can split a task into as many sections as you need.

(TR Y]
LK

B Y

-

Hame

Construction Contract Award 1

Accapt Site
5S1ake ines and grades

Cleanng and Site Grading
Lhilities

Excavation

% B Foundation and Backfill

Sctober 2022
wikl) willl wi} wial

E Footings
Footings Splitt
Footings Split2
Footings Split?

14 %

158 %

Spread Foolings
Caoncrele Piles
Slab on Grade

Wallg

16 % B Exterior Wall Surfaces

iT ¥

Brck

Recurring Tasks
If you have a task that occurs repeatedly during the course of a project, ConceptDraw PROJECT can

help you create it as a recurring task, so you only have to set it up once.

[t

Hovember 202 December 2022
wlld Wik widT will Wl wil
Duration: 4 Dy
Complebe: % :
Milas bore:
Pricrity: e
Markes: [0 s ~|
Costs
Basedre: 11,200 § =
Actual: 1,200 §
Dabes
Sart: 10/ 1073032 R:00 AM
Firush: 10/ 38/ H0ET 20 PM
Deadine: |:||*-:.!¢. ME2 106 PM
Sahedulrg
Tyt
Exffiort drivven:
Task bypes
Types: Sl Task b
Count: 3 .
W
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' — v e e (Y

1% Comstroction Contract Amward 1+ BA12022 Infa =
1% Accept Site olz022 — EI
3% Stake ines and grades —‘_— Durazen: e . Dem =
4% Cleaning and Sae Grading S IR % :
Mbesione:
E%  UNikties L — . e
¢ YEExcemtion 1 —— — Markes: op——— -
:: m:m —— Tm: B :
9% | Excavation Recumingd —— Actuk [s330s |
10 % 5 Foundation and Backsil . tt
12 % Footings Spiiti Deacire: O] #abiza: 06 |
" Foctings Spin2 e g
" Footngs Spiits T -
1%  Spread Footings Effort draven
m r
W% Concrele Pies Types: Recuring Task )
T ¥ Slabon Grade Count: . ®
sw b [T, Period: '5'_{:. o ~ -
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Project

Project dialog can be accessed from Panels button on the View tab.
Project dialog defines the project parameters and allows you to manage a project information from the
Gantt chart and the Multiproject View

Project
Info
Mame:
Start Date:
Finish Date:
Duration:
Budget:
Company:
PM:
Site:
Objective:
Prigrity:

Marker:

nx

| Kitchen Renovation |

| 9/ 9/2022 8:00 AM D'|

|1zfzafzuzz 5:00 AM El- |

Minutes
Hours

Days
ABC Construction |weeks

Maonths
John Smith

| www.abcconstruction. com |

100,000 ¢

| Renovate private kitchen |

|Nn marker w |

Name - Set up project name
Start Date - Display project start day
Finish Date - Display project finish day

Duration - Display project duration. Select the duration
units using the drop-down list.

Budget - Set up project budget
Company - Set up Company name
PM - Set up project manager

Site - Set up project web-site
Objective - Set up project objective
Priority - Specify project priority

Marker - Specify project marker from list
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Resource

Resource dialog can be accessed from Panels button on the View tab.
Resource dialog defines parameters of the project resources and allows you to manage a resource
information in the Resources list,

Resource I x
Info Name - Set up resource name.
Mame: | | Type - Specify one of the following resource
type: Work,; Material; Cost; Equipment or
Type: Work w Company.

Cost: “1 [per hour ~ Cost - Set up resource cost. Work resources are

those with a cost over time. Other types of
Group: Flooring, Landscape E resources have a fixed cost per unit

E-Mail: |J':'E—Sm'ﬂ"@‘5'ma'|":':'m | Group - Set up resource group. The resource

can participate in several groups

Marker: |Nl:| marker s |

E-mail - Set up resource e-mail

Marker - Specify resource marker from list
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Assign Resources

Assign Resources dialog can be accessed from Panels button on the View tab.

Use Assign Resources dialog to assign resources to project tasks,

Open Gantt Chart View and select a task to assign resources.

Select a particular resource from the resources listed at the Assign Resources panel and assign it to a
task by double clicking or pressing the Enter key.

You can even create a new resource using buttons. The new resource will be added to both the Assign
Resource dialog and the Resources list.

The Work resource you have assigned is displayed as 100% implementation. The other type resource is
displayed as 1 unit implementation.You can change this allocation manually after the resource has been
assigned.

Using the Effort Driven scheduling, when you assign or remowe people from a task, the duration of the
task will be the lengthened or shortened based on the number of resources assigned to it.

Assign Resources 1 x

Tiecaus Unis | Work Resource - Displays the resource name.
[ El Excavation o
Bob's Excavalion soco%  &4h &l Unijts - Resource utilization for the current task.
Excavator 1.00 i
| Truck [
o Bobis Excavaion & Work - Man-hours for the Work type resource.
| Excavator i
= Truck &
= B8 Surveyor o u
g :ﬂ::g:; . 5 Add Work resource - Add new human resource
Surveyor2 5000% 6G4h & into resource pool
=] Surveyor 1 -
= &8 Flooring o
| Baker Flooring &
g Concrete mixer S 57 Add Material resource - Add new material
Baker Flooring - .
Comerete mixer 100 a resource into resource pool.
. = . .
e Move to Resources view - Switch to
- - = .
e Resources view

Calendar - Set the specific calendar for Work
type resource
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Solutions

Solution panel contains a list of project management solutions located in Solution Park. It provides
access to the number of project schedule examples, various types of reports and live graphical project
dashboards. Open the example project file to modify it, or generate a tabular, visual and mind map

reports on your project. Access the panel from the button E in the Home tab, or using the Panels
list in the View tab.

1
Solutions
| » MINDMAP Reports q’:""T
P Overview Reports \|_
k P Agile _:_:_r_
k P Dashboards | 3

1. Search window. You can search for the required reports and examples. Enter the keyword in the
search field. The corresponding solutions will be displayed in the panel.

Solutions ax

||:|ashb|:|ard| | ’
F MINDIMAP Reports A

P Overview Reports
F P Agile
k Pi Dashboards

2. Search in ConceptDraw STORE. You can run the ConceptDraw STORE application to search for
the the proper solution in Solution Park

3. Solution section. This section contains the list of available solutions in alphabetical order.

The following options are available here:

a) Use the drop-down button to preview Examples and Reports contained in the certain solution. You
can open them by click.

b) Click to download and install a free, or previously purchased solution using the ConceptDraw
STORE application.

c) Check, to view just solutions that are already installed.




Solutions o x

dashboard
P Knowledge Reports

» MINDMAP Reports

& Custom Report

k PM Agile

= Pt gl
Aol

¥ Project Exchange v
v | Only Installed Solutions

* Reports
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Completed Tasks

P DattEasids

P PM Response
» PM Teams
P Project Exchange

P Resource Usage Reports
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Tabular Reports

Tabular reports in ConceptDraw PROJECT are generated as electronic spreadsheets in MS Excell
format (XLSX). This ability is convenient for your own use and for easily sharing the reports with
stakeholders, even if they don’t have ConceptDraw PROJECT installed. There are more than pre-
designed 30 tabular reports in ConceptDraw PROJECT. Reports are combined into 7 case-oriented
solutions with many kinds of reports. Along with pre-designed tabular reports, ConceptDraw PROJECT
users can create custom reports based on a self-designed Excel template.

The group of pre-designed Table Reports includes the following types of reports:

1. Basic Projects:
o All Task Statuses — report the table of all tasks statuses for each project;
 Milestones — report the table of milestones for each project;
e Send Task List — report the table of tasks for each project;
e Task and Notes — report the table of tasks with start and finish dates and Text Notes.

2. Cash Flow Reports:
e Cash Flow on Projects — report the table of daily expenses per project during one month;
e Cash Flow on Resources — report the table of daily labor expenses per employee during one
month;
e Cash Flow on Tasks — report the table of daily expenses per task during one month.

3. Current Activities Reports:
e Completed Tasks — report the table of completed tasks for each project;
e Critical Tasks — report the table of critical tasks for each project;
e Overdue Tasks — report the table of overdue tasks for each project;
e Tasks in Progress — report the table of tasks in progress with task information for each
project;
e Unstarted Tasks — report the table of unstarted tasks with task information for each project.

4. Knowledge Reports:
e Knowledge Schedule — report the table of all hyperlinks with dates and associated tasks;
e Project Knowledge — report the table of all project hyperlinks;
e Resource Knowledge — report the table of all resources hyperlinks.

5. Oweniew Reports:
e Anonymous Project Ovenview — report the table of time, costs, tasks and resources overview
without Resource names;
e Multiproject Oveniew — report the table of time, costs, tasks and resources overview for each
project.

6. PM Planning:
e All Tasks All Columns List — report the table of entire project schedule including hidden
columns;
e All Visible Columns — report the table of project schedule excluding hidden columns;
o Milestones with Notes and Objectives — report the table of milestones with notes and objectives
for each project;
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Multiproject Goals — report the table of projects objectives for each project;

Multiproject Managers — report the table of projects managers for each project;

Project Team — report the table of project employee including hyperlinks;

Resource Report — report the table of all kinds projects resources for each project;

Top Lewvel Tasks — report the table of project top level phases and tasks with task information
for each project.

7. Resource Usage Reports:
e List of Materials — report the mind map of used materials for each project;
e Materials Utilization — report the table of material resources utilization by tasks;
e Ower Allocated Resources Details — report the table of overallocation periods with task
assignments for each employee;
Ovwer Allocated Resources — report the table of workloads per tasks for each employee;
Resource Report — report the table of all kinds projects resources for each project;
Resource Usage — report the table of resource usage details for the current week;
Resource Usage Summary — report the table of workload periods with costs per employee;
e Who Does What Details — report the table of tasks with statuses per employees for each
project for the current week;
e Who Does What Loading Percent — report the table of employees loading in % during the
period for each project;
® Who Does What Loading — report the table of employees loading during the period for each
project;
e Who Does What When — report the table of daily tasks assignments of employees during
current week for each project;
e Who Does What — report the table of employees workloads by tasks in current month for each
project.

Follow the steps below to make the tabular report on your project:
1. On the Solutions panel find out the suitable report from the list above.

2. Click the report icon to view its preview on the right panel.

Solutions L Report Parameters ax
=
v Curent Activities Reparts - ) ~

The “Completed Tasks™ report generated for yiuur project Construcon Project
répragents the spreadshest contaning the information régardeng "

¥ Bamples the project’s tasks, which are completed, i.e. the tasks which O Lease a New Facity

~ Reports Complete in a Gantt Chart equals to 100%. By default, the Generaie O Kichen Renovation
reporting period is set as a curent week, but optionally it can be [ Ske Arrangement
changed to another desired one. Thas report includes the tasks
with the indication the phases to which they belong, even if these
phases are not 100% completed, and contains the coresponding
detailed information about duration, start and finish dates, cost, - Dates
baselne cost and responsible employeas.

Report Period | Document Timeline
[ === e = e = ]
Completed Tasks e - — - Start

Finish

* Units

Time Unit Use Current Documen =

Critical Tasks
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3. Specify the report parameters using the Report Parameters panel.

Report Parameters

¥ Projects

[¥ Construction Project
[ Lease a New Fadity
O Kitchen Renovation
[ Ske Arrangement

w Dates _
Report Period | Specific Interval N
Start 8/26/2021 @
Finish i August 2021 b
Sun Meon Tue Wed Thu Fri Sat
* Units 25 26 27 28 29 30 AN
1 2 3 4 5 6 7
Time Unit g 9 10 m 12 13

15 16 17 18 19 2 2
2 23 4 »x[3E] 2 8
2 m N 1 2 3 4

[ Today: 8/26/2021

4. Press Generate to create the report.

5. The report will be generated and opened in MS Excel.

4 A B c D E F G H 1
1 Duration _Start Finish  Complete  Cost  Baseline Cost Resource Name
2| & Accept Site od 7/18/2021 100 % 0s 0s
3 7 Stake lines and grades 10.00 d 7/26/2021 8/6/2021 100 % 8,000 % 8,000% Surveyor 1
a & Clearing and Site Grading 20.00d 8/9/2021 9/3/2021 100 % 27,1008 26,3005 Bob's Excavation, Excavator [1]
5 | o Utilities 15d 8/9/2021 B/27/2021 100 % 12,0008 12,000 % Surveyor 2
5 | 10 Excavation 16.00d 8021 823202 100% 21,8208 21,1808 Bob's Excavation, Excavator (1]
7 11 Foundation and Backfill 25.00d 8/9/2021 9/10/2021 70 % 60,100 § 63,700 §
8 | i Spread Footings 15d 8/9/2021 8/27/2021 100 % 17,5005 17,5005  Baker Flooring Concrete mixer [1]
9 | 14 Concrete Piles 10.00d 8/23/2021 9/3/2021 100 % 13,900 5 13,5008  Bob's Excavation, Concrete mixer [1]
10 17 Exterior Wall Surfaces 25.00d 8/30/2021 10/1/2021 100 % 33,700 8 35,900 $
1 : Brick 25.00d 8/30/2021 10/1/2021 100 % 33,7005 19,9006  Bob's Excavation, Excavator [1]
12| 20 Rough-in D rk, Plumbing and El I 15d 8/2/2021 8/20/2021 100 % 36,000 43,800 §
13 Install Heatpumps 15d 8/2/2021 8/20/2021 100 % 17,500 % 17,5005  Baker Flooring Truck [1]
14 22 Venting 5.00d 8/9/2021 8/13/2021 100 % 6,600 § 6,400 5 Bab's Excavation
15 4 Telephone, Security, and Electrical Wiring 10.00d 8/9/2021 8/20/2021 100 % 11,900 % 11,900%  Baker Flooring Truck[1]

ConceptDraw PROJECT User Interface Reference © 2024 CS Odessa corp.
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Custom Repots

ConceptDraw PROJECT allows you to create a tabular project report based on a custom Excel template.

Using the Report Wizard you can generate a custom project status report based on the ConceptDraw

PROJECT file data. Use an Excel document to create a report template. With the help of customizable

macros place the necessary data in the required cells.

Follow the steps below to make the tabular report on your project:

1. Install the Custom Report Solution via ConceptDraw STORE. Find it in the Project
Management category on the Solutions tab.

2. Find out Custom Reports in the Solutions panel.

3. Click the report icon to view its preview on the right panel.

: Custom Report
. ] - Projects
 Custar Repart B
The "Custom Report” is Custom Report. That's all we know. [ Construction Project
* Reports O Lease a New Facity
e ——— A ] = ] £ ; G H I O Kichen Renovatian
— 1 [ 5ke Arrangement
- 2 -
Gt — 3
— 4 - * Dates
5
Custorn Excel Repert 13 ~ Report Period | Document Timeline
7 2
Custom - — et '
Earned Value Management 8 Finish 1z .
(EVM) Dashboard ] " 11/25/2028
0 ]
3 swdge Rip
Enewledge Reports = - Units
¥ MIWDMAR Reparts 12 -
13 Time Undt Use Current Documen =
¥ Overview Reports
4
k Pid Agile 1% * Miscellaneous
¥ P Dashboards :: «Sedoct Exoel templste>
¥ PM Does
¥ PM Easy

Oy [rtabed Sobstions

Report Parameters 1 x

¥ Projects

Construction Project
[0 Lease a New Fadity
O Kitchen Renovation

[0 Sie Arrangement

¥ Dates

Report Period | Specific Interval -

Start 8/26/2021 2
Finish ‘ August 2021 '
Sun Mon Tue Wed Thu Fr Sat
* Units 25 26 27T 28 29 3 AN
1 2 3 4 5 6 7
Time Unit 8 9 W M 12 13 4

15 16 17 18 19 20 21
2 23 24 3 27 28
2 30 n 1 2 3

) Today: 8/26/2021

2. Press Generate to create the report.

3. The report will be generated and opened in MS Excel.
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The Custom Reports solution includes the installation of an add-on for MS Excel. The CDProject menu
item will appear on the MS Excel toolbar after the successful installation of the solution.

The Report Wizard supplied with add-on allows you to build custom templates for various project reports
based on the ConceptDraw PROJECT file data.

2021-09-01_18-27-56_Project Report_Example 2 - Excel

Inzert Page Layout Formulas Data Review View Help CD Project ';) Tell me what you want to do

k] Project Name 2 Project Manager k] Project Site k] Project Start Date 2d Project Cost O Task Narme (ol Task Start Date 5 Task Cost
:1-( Project Budget -':;.1 Praject Description 3,-‘ Praject Duration :,-‘ Praject Finish Date ::,1 Task Duration :?H Task Finish Date +1 Task Costl
b Project Company 2 Project Goal 2 Project Priority k] Project Complete 5 Task Priority 4 Task Complete
Project Task
H ©-
4 v Jx
A B C D
1
2
W Project Name B 1ask Name [~ B 1ask cost -
4
5 |=COPRI_PROJECT_NAME() =COPRI_TASK_NAME() =COPRI_RESOURCE_NAME() =CDPRI_TASK_COST("##t> 10000")
6
How it works

1. Use an Excel blank Workbook to create a report template. With the help of customizable macros,
place the necessary data in the required cells.

2. In each line of the Template Sheet, the Report Wizard searches and processes certain macros. For
example:

CDPRJ_PROJECT_NAME () - displays the name of the Project.

CDPRJ_TASK_DURATION () - displays the duration of the Task.

CDPRJ_RESOURCE_TYPE () - displays the type of the resource.

CDPRJ_TASK_NAME ([PH]) - displays only Phases.

CDPRJ_TASK_NAME ([T]) - displays only Tasks

CDPRJ_TASK_NAME ([M]) - displays only Milestones

3. Filters by certain conditions can be used as parameters. For example:

CDPRJ_TASK_NAME (## = " Task1 ") - displays the name of the task if this name is "Task1".
CDPRJ_TASK_DURATION ("##> 5 & ## <10") - displays the duration of tasks from 5 to 10 units.

4. Use the saved Excel Template to start generating a report from the Report section in the Solutions
panel.

5. The Report Wizard loads the Excel Workbook with the report template and creates a new Workbook.

A B c D

3 |Project Name Task Name Resource Name Task Cost
4

5 Construction Project 1_4.Clearing and 5ite Grading  Bob's Excavation "17085.0

6 Construction Project 1_4.Clearing and Site Grading  Excavator "17985.0

7 |Construction Project 1_7.Foundation and Backfill Bob's Excavation '63063.0

8 Construction Project 1_7.Foundation and Backfill Surveyor 1 '63063.0

9 | Construction Project 1_7.Foundation and Backfill Baker Flooring '53063.0
10 | Construction Project 1_7.Foundation and Backfill Surveyor 2 '53063.0
11 Construction Project 1_7.Foundation and Backfill  Truck '63063.0
12 | Construction Project 1_7.Foundation and Backfill Concrete mixer "63063.0
13 | Construction Project 1_7.1.Footings Surveyor 1 "11200.0
14 Construction Project 1_7.2.5pread Footings Baker Flooring "13266.733

15 | Construction Project 1 7.2.5pread Footings Concrete mixer '13266,?33
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Mind Map Reports

The mind map reports in ConceptDraw PROJECT are generated as ConceptDraw MINDMAP files
(CDM2Z). You can generate the report mind map with the help of compatibility between PROJECT and

MINDMAP.

1. Find out MINDMAP reports in the Solutions panel.

2. Click the report icon to view its preview on the right panel.

I 2]
2

> MINDMAP Reparts

b Examples
* Reports

Completed Tasks

Critical Tasks

Completed Tasks

The "Completed Tasks™ report formed for your
project represents the Mind Map composed from

the hierarchy of your project tasks which are

already completed at the time of the reporting
period. By default, the reporting period is a current
maonth, but you can change it to the desired one
befare generating this report. For the multiproject,
a multipage Mind Map document will be created.

e Sttt - @ e s
. S ey — ’

Report Parameters B x

* Projects

[# Construction Project
O Lease a New Faciity
O Kitchen Renovaton

O Ske Arrangement

 Dates

Repart Period | Document Timeline

Start FI16/2021
Finish 11/25/2021

3. Specify the report parameters using the Report Parameters panel.

Report Parameters a2 x
¥ Projects
[ Construction Project
O Lease a New Fadity
O Kichen Renovation
O Ste Arrangement
¥ Dates
Report Period | Specific Interval -
Start [ 872672021 @
Finish 1 August 2021 v
Sun Mon Tue Wed Thu Fr Sat
~ Units 3 2% 27 28 X 30 3N
1 2 3 4 5 6 1
Time Unit 2 9 10 M 12 13 14
15 16 17 18 19 20 21
2 23 M4 B 27
29 30 N 1 2 3 4

[ Today: 8/26/2021
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4. Press Generate to create the report.

5. The report will be generated and opened in ConceptDraw MINDMAP

@ Irstall Heatpurrps
@ steke ines and grades

@.Vm ! @ ::Lgi:: Ductwod, Pumbing and
@ Talsghens. m_mﬂnrﬂ] Completed Tasks for - @ Caaring and Ste Gradng
\Wiring i Construction Project J
e = — e

QO = Q-Emiuwus.m © v

Q) sewsronens

.—\ @_-qumaﬂsm
@ Concmte Fies f

ConceptDraw PROJECT User Interface Reference © 2024 CS Odessa corp.



72

Visual Reports

Conceptdraw PROJECT has sewveral types of visual reports that can help assess visually the difference
between planned and actual project data. Conceptdraw PROJECT provides user with the possibility to
track how the project is going. Project Manager can compare the actual data with the planned and
assess possible measures to resolve issues. The main tool for effective monitoring of the project
implementation is the ability to save project Baseline. It includes the value of Baseline Start, Baseline
Finish and Baseline Cost. All these indicators can operate effectively only in one case - if the project
manager, constantly receives information about the actual data compared with planned.

Conceptdraw PROJECT has seweral types of visual reports that can help to assess visually the difference
between planned and actual project data. The visual reports in ConceptDraw PROJECT are generated as
ConceptDraw DIAGRAM files (CDDZ).

1. On the Solutions panel find out the suitable visual report.
2. Click the report icon to view its preview on the right panel.

Selutions Fx o | Proi Period Repert Parameters L
ACCUAIS per Froject Fernod
|! h J * Prajects
* Visual Reports a

The “actuals per Praject Pariad” report creatad for [ Construction Project
your project llustrates the projedt’s actuals per

* Exsmples project report penad uging a visual farm of Line [ Lease a New Facky

- Reports Graph. Thee graph is divided by weeks and the key [ Kichen Renovaton

P powks represent the projecd expenses for each [ Ste Amangement
witnith within a réporting penoed. In addition, nearby
T you can observe the project expenses by weeks
presentad inthe table,
== ——

Accumuletive Budges Actuals
=

Actuals per Project Period

Y 1

Auctual Corgtz =

3. Press Generate to create the report.

4. The report will be generated and opened in ConceptDraw DIAGRAM
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Construction Project

TS

Actusls per Project

Period Report

Report Cade:  2021-08-27

Actfuals per Project Penod

¥

2021-07-16
2021-07-23
2021-07-30
2021-08-06
2021-08-13
2021-08-20
2021-08-27
2021-08-03
2021-08-10
2021-08-17
2021-08-24
2021-10-01

fouals Lo

e~ b

o
3200
141217
36TFEE
365304
3519152
30817
133183
TH06ET
G740
G740
1348

-0 L

TE-- s

) i HIRG
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Dashboards

ConceptDraw PROJECT provides the possibility of creating visual project dashboards. The PM
Dashboards solution allows generating accurate, timely, and professional looking Project Dashboard,
Radar Chart and Tactical Dashboard. Project Dashboards are the helpful tool for tracking project
progress and catching critical points. The ConceptDraw PROJECT's dashboards are opened as
ConceptDraw DIAGRAM documents (CDDZ).

1. Find out the PM Dashboard solution in Solutions panel and select the dashboard type you need to
create.

2. Click the certain dashboard icon to view its preview on the right panel.

Droas == hBAsSEe
) Project dashboa
] ! o - - Pagjiety
= PA Dadhl e
Thee “Froject Dashboard™ report generated for your propect offers the ConceptiDraw DIAGRAM document H Constructon Projed
¥ Exampl T the infoemation acconding to your propect’s stabe on one page, which s draded into B Lease a Miw Facky
mples several parts daplayng peneral inlomabon about your progect, the guantitatree rabos of progecd tasks p—
- - ithat are late, on tme and early, the guanbtatree ratios of resources = overallorated, normally and = Kichen Rerenvaton
hopo underalizzated, a5 well 35 Lite, oaily 300 o e MESoUrces with thie hep of visual ki peromands & Ste Arangerment

meheators. You can also find the bars dep«ng the data on project comghste, costs and budget, the kst

of Eamd Vabst Schidubt Indecators cakidated fof vour projedt, anvd ks o addtonal oraphezal

reparts. The usage of several brsght colours provades addianal visual assistance n nscanty
recegriring whether aoerythrsd is moving waell in your project amd n identiicaion the problem areas.

» ? — Thish FOpOIE Tor B maltpana et will £ontIn M mdradudl pag Tor Seh prapct and ang page
fnmariers) the rdaimation about Ml pro o’ cospleted.

Pecjet Dushbourd Dashbaard, 2015 dogi

| o o=

3. Press Generate to create the dashboard.

4. Project Dashboard, Radar Chart and Tactical Dashboard will be generated and opened in
ConceptDraw DIAGRAM.
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Project Dashboard

The ConceptDraw PROJECT's dashboard displays the current status of your project and shows where
you need to direct your management efforts. A Project Dashboard diagram is generated from your
project data and will be opened in ConceptDraw DIAGRAM.

Project Dashboard is divided into sewveral parts, each of them provides an oveniew of the project status.
In other words Project Dashboard contains a summary of project information - general information about
project, Tasks Completion, Resource and Tasks indicator, Project Complete indicator, Cost and Budget,
Resource Allocation, and Earned Value Schedule Indicators.

Dashboard, 2021-Aug-31
Construction Project

Project manager: John Smith Start: 7/9/2021 Duration: 76d
Goal: Build 3 tumkey family coage Finish: 10/22/2021 Cormplete: 32%% @
Budget:  $245,880

Tasks Resources and Tasks Project Complete
63%
Late taghs (787m/h)
On time tasks 29 v
32% (562m/h) 100%
6% Late tasks in progress @
b0%,, 3% Not started
5% 1
Cost and Budget
$180,000
- v
481,776 $210.880

25 most expensive tasks
Overcosted tasks

Resource Allocation Earned Value Schedule Indicators
ACWP  B1,7765 CPl i

averallocated 25% (2 people) BCWP 86,4205 SPI 1
BCWS 113,514% EAC 199548
normally 50% (4 people) sV -270%4 VAC 11332
SV Li] TCPI 1
underallocated 25% (2 v 4644

Vb U]

1. The block of general information contains the data about name of Project Manager, goal, project’s
start and finish dates, completing status and budget.

ConceptDraw PROJECT User Interface Reference © 2024 CS Odessa corp.
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2. Tasks block provides the information about tasks completing. The indicators have a common color
notation: red denotes late tasks, yellow shows a normal status (on time tasks), and green indicates
tasks that are ahead of schedule (early tasks). Some indicators have links to additional graphical
reports, double-click the link to open the corresponding diagram with all additional information in full
screen mode. The list of tasks will be displayed with detailed information regarding their planned and
actual level of completion, and assigned resources.

3. Resource and Tasks section allows to see all information about project’s work resources. Resources
are divided on groups on this pie chart, the color indicates if the group of resources is late (red color),
ahead (green color), or in time (yellow color). The quantity of resources which contains each group is
indicated in percents and by number on each sector. You can also view the degree of late or ahead of
resources groups - the yellow sector is always on the circle’s border, green sector exceeds the circle’s
border, and red sector tends to the center, the degree of remoteness from the border to one side or
another is a degree of late or ahead.

This information is particularly useful for small projects, because for them the contribution of each
participant is greatly and valuable, and it's important that each work regularly and in time. Resource and
Tasks indicator for large projects allows to see immediately the red sector and resources that are much
late. Click the Resource rate link to receive the detailed information for each work resource of project:
which quantity of tasks it executes and what are their statuses.
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4. Project Complete indicator has three points you have to pay attention to color, current completion and
planned completion. Progress bar shows current project completion, below you can see the completing
status in percentage. Arrow shows planned project completion. You can click to get the additional
information about late tasks in progress and not started tasks, the additional diagrams will be opened on
the separated pages.

5. Cost and Budget Indicator shows at the right the allocated project budget, and progress bar shows its
actual cost. The color indicates whether the project execution is within budget or, in other words, it does
not exceed the project actual cost of allocated budget. You can click to get the additional information
about 25 most expensive tasks and over-costed tasks.

6. Resource Allocation section allows to visually see what resources are over-allocated, under-allocated,
and with normal status. Ower-allocation is the result of assigning more tasks to a resource than the
resource can accomplish in the working time available, under-allocation is assigning a resource to work
fewer hours than the resource has available. This information is represented in the form of colored bars,
and in percentage with information about quantity of persons at the brackets.

7. Earned Value Schedule Indicators [10] is a set of calculated project indicators:

o ACWRP (Actual Cost of Work Performed) - is calculated as the sum of the products of actual
costs of the task on the task complete for all tasks.

o BCWP (Budgeted Cost of Work Performed) - is calculated as the sum of the products of
baseline costs of the task on the task complete for all tasks.

o BCWS (Budgeted Cost of Work Scheduled) - is calculated as the sum of the products of

baseline costs of the task on the planned task complete for all tasks.

SV=BCWP-BCWS

SV%=(BCWP-BCWS)/BCWS, BCWS#0

CV=BCWP-ACWP

CV%=(BCWP-ACWP)/BCWP, BCWP#0

CPI=-BCWP/ACWP, ACWP#0

SPI=BCWP/BCWS, BCWS#0

EAC=ACWP+(BAC-BCWP)/CPI, where CPI#0and BAC is calculated as the sum of the

baseline costs of all tasks.

VAC= BAC-EAC

o TCPI=(BAC-BCWP)/(BAC-ACWP)
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Radar Chart

Radar Chart visually shows the degree of project completion. Each axis on the diagram corresponds to
one chain of linked milestones, and the number of marks on the axis corresponds to the number of
millstones.

w34, 22 Aug 2021 w35, 29 Aug 2021
# Mame Start Finish
22 23 24 25 2% 27 28 20 30 31 O
1% B Project 812212021 9221201
2% Mew ProductLaunch Br2212021 8312021 G— 8122/2021
3% Phase 1-Flanning the Launch 812212021 8312021 S— 8/22/2021
4% Definethelaunch group 8/24/2021 2242021
5k Define salesgoals 8/24/2021 — 824/2021
Define launch goals (launch
+
i timing and publicity objectives) 8/25/2021 8252028
T |dentify partners (if needed) 812512021 8/25/2021
g% |dentify channel partners 812502021 812502021
gtk |dentify retail partners 812502021 8/25/2021

Purple polygon includes all milestones of all chains, the blue polygon includes the completed of them.
The ratio of the areas of these polygons displays a degree of project completion.

Radar chart, 2021-Aug-31

Lawnch budg =t
Planning Compleie approval
Define Lawnch Budg =t Define the lsunch
group

|dentify partners {if
nead ed)
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Tactical Dashboard

Tactical Dashboard allows to evaluate the progress of the project for some indexes and to compare it
with an expected progress. There are compared the current indexes for an unfinished project on the
tactical dashboard. So, it helps you make the tactical decisions.

1%
2t
3%
4%
5%
6%
i
5%

Mame

El Marketing Research
Definethelaunch group
Define salesgoals
Define launch goals (launch tirming
El Planning the Launch
Definethelaunch group
Define salesgoals

Define launch goals (launch timing

Start

8302021
8302021
23072021
8302021
8312021
81312021
8312021
8/312021

Finish
83112021
8/31/2021
83172021
8/31/2021
83112021
8/31/2021
83172021
8/31/2021

w3b, 29 Aug 2021 w36, 05 Sep 2021
28 29 30 31 01 02 03 04 05 06 OF 08 09 10

James Smith; John Brown: Mary Williams

David; Mike; Clarc

David; Mike; Clarc

James Smith; John Brown; Mary William

A Tactical Dashboard diagram is generated from multiple project data and will appear in ConceptDraw
DIAGRAM. There are compared the main values: Cost, Work, Date and Work Resource Cost. The
Complete of the project is taken as a measure of comparison.
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Tactical dashboard, 2021-2ug-31

HE
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A et i Total ima

B
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HE

- r
Campak

Tactical dashboard represents four positive quadrants of Cartesian coordinate system. The projects are
displayed as circles on the plane in this coordinate system. Each of the diagrams reflects four indexes:

e Xaxis is a project Complete;

e Y axis is a relative estimated completion of project by any index that is calculated as quotient of

the current value and the total value;

e Diameter of the circle is an absolute estimated completion by any index that is calculated as a

difference of the current value and the total value;

e Color of the circle is a comparison of the relative estimated completion and project Complete:
green reflects the ahead, red - the lag, and yellow - in time.

Note that diameters of all circles in the same coordinate system are standardized to the biggest that is
taken as 100. A relative estimated completion is depicted reversed. The sign of project progress: the
circles go down, the color is yellow or green, the diameters decrease.
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Let’s see in details each of four diagrams represented on the Tactical

1. Diagram with an estimate by the actual cost (“Actual cost / Total cost”).

There are compared Actual cost and Total cost on this diagram. Actual cost is a sum of actual costs of
all tasks of the project that are multiplied on their Complete. Total cost is a sum of actual costs of all
tasks of the project.

2. Diagram with an estimate by the actual man-hour (“Actual man-hour / Total man-hour”).

There are compared Actual man-hour and Total man-hour on this diagram. Actual man-hour is a sum of
Work values of all tasks of the project that are multiplied on their Complete. Total man-hour is a sum of
Work values of all tasks of the project.

3. Diagram with an estimate by the actual time (“Actual time / Total time”).

There are compared Actual time and Total time on this diagram. Actual time is a period between more
earlier date from project finish or current date, and project start date (Actual time=min (Finish date,
Current date) - Start date).

Total time is a project duration, is calculated as difference between project finish and start dates (Total
time=Finish date - Start date).

4. Diagram with an estimate by the actual cost of human resources (“Actual cost human resources /
Total cost human resources”).

There are compared Actual cost human resources and Total cost human resources on this diagram.
Actual cost is a sum of Costs for all resource’s tasks that are multiplied on their Complete with Work
type in the project. Total cost human resources is a sum of Costs for all resource’s tasks with Work type
in the project.
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Slide Navigator

You can create a presentation slides from a project file using the Capture Slides button on the
Share tab. Slides will appear in the pop-up Slide Preview panel.
Slide Preview panel can be accessed from Panels button on the View tab.
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You can manage the slides in the Slide Preview panel using the context menu.

= capture slide Capture Slide - Capture slide from a visible area of the current
. Delete <lidel - project view
elete Slide(s) : Delete Slide(s) - Delete the selected slides
Save As PNG * Save as PNG - Export to PNG according to chosen option
Create Presentation From  # (S Al Slides..,

Selected Slide(s)...

Create Presentation from - Export to PowerPoint Presentation
according to chosen options

@ Al Slides...

Selected Slide(s)...
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Hypernote

Hypernote panel can be accessed from Panels button on the View tab.

MNote

A test of transaction focuses on the individual transactions
that make up an accoubt balance

Hyperlinks
Link Owner
Test of Transactions
project.com Test of Transactions
Cash and Equivalents Test of Transactions
i )
Q}, || | | % Show Subitems d‘;‘

Notes - Notes section allows adding text Notes to project tasks, scheduled at the the Gantt chart View.
You can edit text Notes both from the Notes panel and the Notes column on the project grid. To display
the Notes column on the grid,

use the Column Customization dialog.

Hyperlinks - You can add seweral files hyperlinked to one task in your project file. You can add
hyperlinks to documents or Web pages. Hyperlinks can also jump to tasks, resources or projects within
your project file. The number of hyperlinks, you can add to each project item is unlimited.

2 hyperlink to URL;
“ hyperlink to document;
« hyperlink to folder,
= hyperlink to email address;
hyperlink to other item in the current project file;

You can add a hyperlink by clicking the Hyperlink icon % in the Gantt view grid.
To display the Hyperlink column on the grid,use the Column Customization dialog.

Any item with a hyperlink will be marked with icon: c

An item that has multiple hyperlinks will display this icon: e

This panel brought together the functions of adding text notes and multiple hyperlinks. The earlier
versions of ConceptDraw PROJECT had two different panels for these functionalities.
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Links

Links panel can be accessed from Panels button on the View tab. It shows tasks linked with selected
task. Once you have created a list of project tasks, you need to edit your project schedule in more
detail by moving tasks, setting dependence between project tasks, or making other changes using the
Links panel tools. For example: you have tasks that you would like to link together. But, also you need

to add lag time between selected task and the preceding task on which it depends. You can make this
also using the Predecessors dialog.
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If you need to set a time lag between selected task and the subsequent one, you have to use the
Successors tab.
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Keyboard

Operation

ConceptDraw OFFICE Tools

Ctrl + Shift+ M

Create ConceptDraw MINDMAP file

Documents and Windows

Ctrl +N Create a New Document
Ctrl+0 Open a Document
Ctrl +S Save the active document

Ctrl + Shift+S

Save the active document under a new file name

Ctrl +P Print Preview
Ctrl +Alt+P Print the active document
Ctrl +F Activate the Quick Find tool

Ctrl +Shift+F

Open the Find dialog

Ctrl +H Open the Replace dialog
Ctrl +F4 Close the active document
Ctrl +W

Ctrl + Tab Activate the next window

Ctrl + PageUp, Ctrl +
PageDown

Activate the next project in Gantt Chart View

Alt +F4

Quit ConceptDraw PROJECT
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Keyboard Operation

Presentation

Ctrl + Shift + C Capture Slide (Visible area)

Application

F1 Call Help System

Alt +P Preferences (Application settings)

Ctrl +F1 Call ConceptDraw PROJECT About Dialog
Tasks

Insert Insert new task

Ctrl + Enter Add new subtask

Shift + Enter Insert new task after selected

Alt + Enter Add task to end of current level

Delete Delete selected task(s)

Ctrl+ M Mark task as milestone

Ctrl +B Create deadline for a task

Ctrl + Right Indent task

Ctrl + Left Outdent task

Ctrl + Down Move item to the next position (one line down)
Ctrl + Up Move item tone line up

Shift + Left Collapse selected phase

ConceptDraw PROJECT User Interface Reference © 2024 CS Odessa corp.
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Keyboard Operation
Shift + Right Expand selected phase
Ctrl +L Link selected tasks

Ctrl +Shift +L

Unlink selected tasks

Ctrl+G Go to selected task

Enter Fast adding of new entities
Projects(s)

Insert New project

Ctrl +Shift +N

New project

Delete Delete project

View

Tab Switch the View

Ctrl +Alt+G Switch to Gantt Chart View

Ctrl + Alt+R Switch to Resource List View

Ctrl + Alt +) Switch to Multiproject Dashboard
Ctrl + Alt+U Switch to Resource Usage View
Ctrl +R Call Reports dialog

Shift + Mouse wheel

Horizontal Scroll

Click in Print Preview

Change zoom level (in cycle)

Page Up

Scroll up in Print Preview

ConceptDraw PROJECT User Interface Reference

© 2024 CS Odessa corp.
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Keyboard Operation

Page Down Scroll down in Print Preview

Editing

Ctrl+2Z Undo the last operation

Alt + Backspace

Ctrl+Y Redo what was reserved by Undo

Ctrl +X Cut the selection to the Document

Shift + Del

Ctrl +C Copy the selection to the Document

Ctrl +V Paste the content from the Document

Shift + Insert

Esc Close Dialog

Selecting

Select with Shift Allow to select several tasks

Select with Ctrl Allow to select several tasks (from the first to the
second)

Ctrl + A Select all the tasks on document

Esc Deselect

ConceptDraw PROJECT User Interface Reference © 2024 CS Odessa corp.
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